
1

Cove
Document Scanner

User Manual

♦ Please read this manual before operating this scanner.
♦ After you finish reading this manual, store it in a safe place for future reference.
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International ENERGY STAR® Office Equipment Program
As an ENERGY STAR® Partner, Canon Electronics Inc. has 
determined that this machine meets the ENERGY STAR® Program 
for energy efficiency.
The International ENERGY STAR® Office Equipment Program is an 
international program that promotes energy saving through the use 
of computers and other office equipment.
The program backs the development and dissemination of products with functions 
that effectively reduce energy consumption. It is an open system in which business 
proprietors can participate voluntarily. The targeted products are office equipment, 
such as computers, displays, printers, facsimiles, and copiers. The standards and 
logos are uniform among participating nations.

Trademarks
Canon and the Canon logo are registered trademarks of Canon Inc. in the United 
States and may also be trademarks or registered trademarks in other countries.
Microsoft and Windows are registered trademarks of Microsoft Corporation in 
the United States and are trademarks or registered trademarks of Microsoft 
Corporation in other countries.
ISIS is a trademark of EMC Corporation, in the United States.
Intel and Pentium are registered trademarks of Intel Corporation.
Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated.
Other product and company names herein are, or may be, the trademarks of 
their respective owners.

Copyright
Copyright © CANON ELECTRONICS INC. 2008 ALL RIGHTS RESERVED

No part of this publication may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying and recording, or by any 
information storage or retrieval system without the prior written permission of 
CANON ELECTRONICS INC.

Disclaimers
The information in this document is subject to change without notice.

CANON ELECTRONICS INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD 
TO THIS MATERIAL, EITHER EXPRESS OR IMPLIED, EXPECT AS PROVIDED 
HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO 
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF 
USE OR NON-INFRINGEMENT. CANON ELECTRONICS INC. SHALL NOT BE LIABLE 
FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE, 
OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.
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Thank you for purchasing the Canon imageFORMULA DR-3010C. Please read this 
manual thoroughly before using the scanner to familiarize yourself with its 
capabilities, and to make the most of its many functions. After reading this manual, 
store it in a safe place for future reference.

The following symbols are used in this manual to explain procedures, restrictions, 
handling precautions, and instructions that should be observed for safety.

WARNING
Indicates a warning concerning operations that may lead to death or 
injury to persons if not performed correctly. To use the machine safely, 
always pay attention to these warnings.

CAUTION
Indicates a caution concerning operations that may lead to injury to 
persons, or damage to property if not performed correctly. To use the 
machine safely, always pay attention to these cautions.

IMPORTANT
Indicates operational requirements and restrictions. Be sure to read 
these items carefully to operate the machine correctly, and avoid 
damaging the machine.

NOTE
Indicates a clarification of an operation, or contains additional explanations 
for a procedure. Reading these notes is highly recommended.
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To ensure the safe operation of this scanner, be sure to read the safety warnings
and precautions described below.

The performance of this scanner is affected by the environment in which it is
installed. Make sure that the location where the scanner is installed meets the
following environmental requirements.

• Provide adequate space around the scanner for operation, maintenance, and
ventilation.

• Provide adequate space in front of the scanner for documents output after
being scanned.

• Avoid installing the machine in direct sunlight. If this is unavoidable, use 
curtains to shade the scanner.

• Avoid locations where a considerable amount of dust accumulates.

• Avoid warm or humid locations, such as in the vicinity of a water faucet, water
heater, or humidifier.

• Avoid locations where ammonia gas is emitted.

• Avoid locations near volatile or flammable materials, such as alcohol or paint
thinner.

• Avoid locations that are subject to vibration.

Installation Location

1. Important Safety Instructions
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• Avoid exposing the scanner to rapid changes in temperature. If the room in
which the scanner is installed is cold but rapidly heated, water droplets
(condensation) may form inside the scanner. This may result in a noticeable
degradation in scanning quality.

• The following conditions are recommended for optimal scanning quality:
- Room temperature:10°C to 32.5°C (50°F to 90.5°F)
- Humidity: 20% to 80% RH

• Avoid installing the scanner near equipment that generates a magnetic field
(e.g. speakers, televisions, or radios.)

• Connect only to a power outlet of the rated voltage and power supply frequency
(120 V, 60 Hz or 220-240 V, 50/60 Hz depending on your region).

• Do not connect other electrical equipment to the same power outlet to which
the scanner is connected. Also, when using an extension cord, make sure that
the extension cord is rated for the current requirements of the scanner.

• Never disassemble or modify the AC adapter, as it is dangerous.

• The power cord may become damaged if it is often stepped on or if heavy
objects are placed on it. Continued use of a damaged power cord and AC
adapter can lead to an accident, such as a fire or electrical shock.

• Do not use the power cord while it is coiled.

• Do not pull directly on the power cord. When disconnecting the power cord,
grasp the plug and remove it from the outlet.

• Keep the area around the power cord clear of objects so that the power cord can
be disconnected easily in an emergency.

• Do not use an AC adapter other than the one provided with the scanner. Do not
use the AC adapter provided with the scanner with other products.
Model: MG1-4315

• If you have any questions regarding the power supply, contact your local
authorized Canon dealer or service representative for further information.

• When moving the scanner, always hold it with both hands to avoid dropping it.
The scanner weighs approximately 6.4 lb (2.9 kg).

• Make sure to disconnect the interface cable and AC adapter before moving the
scanner. If the scanner is transported with these items connected, the plugs and
connectors may be damaged.

AC Adapter

Moving the Scanner
DR-3010CDR-3010C
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WARNING
Note the following precautions whenever using the scanner. Failure to do so 
may result in a fire or electric shock.

• Never use alcohol, benzene, paint thinner, aerosol sprays, or any other highly 
flammable substance near the scanner.

• Do not cut, damage, or modify the power cord. Do not place heavy objects on 
the power cord, and do not pull or excessively bend the power cord.

• Never connect the power cord when your hands are wet.
• Do not connect the scanner to a multiplug power strip.
• Do not knot or coil the power cord as this may result in a fire or electric shock. 

When connecting the power cord, make sure that the power plug is securely 
and completely inserted into the power outlet.

• Do not use a power cord or AC adapter other than the ones provided with this 
scanner.

• Do not take the scanner apart or modify it.
• Never try to take the AC adapter apart or modify it in any way, as this is 

dangerous.
• When cleaning the scanner, turn the power switch OFF and disconnect the 

power cord from the power supply.
• Clean the scanner using a slightly dampened cloth which has been well wrung 

out. Never use alcohol, benzene, paint thinner, or any other flammable 
substances.

• If the scanner makes strange noises, or gives off smoke, heat, or strange odors, 
or the scanner does not function or other abnormalities occur when you use the 
machine, immediately turn the power switch OFF, and disconnect the power 
plug from the power outlet. Then, contact your local authorized Canon dealer or 
service representative for further information.

• Do not drop the scanner, or subject it to impact or strong shock. Should the 
scanner ever become damaged, immediately turn the power switch OFF, and 
disconnect the power plug from the power outlet. Then, contact your local 
authorized Canon dealer or service representative to have the unit serviced.

• Before moving the scanner, be sure to turn the power switch OFF, and 
disconnect the power plug from the power outlet.

CAUTION
• Do not install the scanner on a surface that is unstable or tilted, or in an area 

subject to excessive vibrations, as this may cause the scanner to fall, 
resulting in personal injury or damage to the scanner.

• Never place small metal objects such as staples, paper clips, or jewelry on the 
scanner. These items may fall into the scanner, and cause a fire or electric 
shock. Should such objects ever fall inside the scanner, immediately turn the 
power switch OFF, and disconnect the power plug from the power outlet. Then, 
contact your local authorized Canon dealer or service representative to have the 
unit serviced.

• Do not install the scanner in a humid or dusty location. Doing so might cause a 
fire or electric shock.

• Do not place objects on top of the scanner. Such objects may tip or fall over, 
resulting in personal injury.

• Connect only to a power outlet of the rated voltage and power supply frequency 
(120 V, 60 Hz or 220-240 V, 50/60 Hz depending on your region).

• When unplugging the power cord, grasp it firmly by its plug. Do not pull directly 
on the power cord, as this may damage or expose the cord's internal wiring, 
resulting in a fire or electric shock.

• Leave sufficient space around the power plug so that it can be unplugged easily. 
If objects are placed around the power plug, you will be unable to unplug it in an 
emergency.

• Do not allow water or flammable substances (alcohol, paint thinner, benzene, 
etc.) to spill into the scanner, as this may result in a fire or electric shock.

• Turn OFF the power switch for safety when not using the scanner for a long 
period of time, such as overnight. Also, turn OFF the power switch, and 
disconnect the power cord from the power outlet for safety when the machine 
will not be used for an extended period of time, such as during consecutive 
holidays.

• Do not wear loose clothing or jewelry that may get caught in the scanner while 
you are using it. This may result in personal injury. Be extra careful of neckties 
and long hair. If anything becomes caught in the scanner, immediately 
disconnect the power cord to stop the scanner.

• Be careful when loading paper into the scanner and when removing jammed 
paper. It is possible to cut your hand on the edge of a sheet of paper.

Handling
DR-3010CDR-3010C
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• When disposing of this scanner, be sure to follow all local ordinances and laws
or consult with the retailer who sold you the scanner.

The main features of the DR-3010C document scanner are described below.

Compact Size
The dimensions of the scanner are as follows: 12.2" (310 mm) (W) x 9.1"
(230 mm) (H) x 23.0" (583 mm) (D) (with the tray open).
(The size of the scanner with the tray closed is 12.2" (310 mm) (W) x 7.8" (197 
mm) (H) x 11.5" (292 mm) (D).)
Fast Document Feeding
The scanner can scan a maximum of 30 documents per minute in a range of 
sizes from business card to LTR/A4 size.

Scanning conditions: Black-and-white/color, LTR/A4, portrait orientation, 
one-sided/two-sided, 200 dpi

High Image Quality
The 600 dpi optical resolution sensor incorporated in the scanner enables 
documents to be scanned with high image quality.
Eject Tray
The eject tray enables scanned documents to be stacked. Open the eject tray 
when scanning documents that are not output smoothly. Scanned documents 
can be output without opening the eject tray.
USB Link Switch
The power of the scanner can be linked to be automatically turned ON/OFF in 
accordance with the power of the computer.
USB 2.0 Interface
The scanner supports Hi-Speed USB 2.0.
Color/Grayscale Support
Documents can be scanned in 24-bit color or 256-level grayscale.
Supports a Variety of Scanning Modes
The scanner supports the following scanning modes, depending on the 
document type:

Single-sided/double-sided mode
Feeding continuously or by sheet

Card Scan
You can scan plastic cards and IDs that are the sizes matching ISO7810 
standards.
Paper Size Detection
The scanner automatically detects the size of a scanned document and 
eliminates any unnecessary space around the edges of the image when storing 
the image, even when storing a document of irregular size.

Disposal 2. Features of the DR-3010C Document Scanner
DR-3010CDR-3010C
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Auto Color Detection
The scanner detects whether the scanned document is in color or black-and-
white, and saves the image in the same format as the document.
Folio Scan
You can scan folded documents. The scanner will scan both sides and combine
the scanned images into a single image.
Deskew
The scanner straightens scanned images when it detects that the document was
placed askew.
Ultrasonic Double Feed Detection
Ultrasonic waves are used to detect pages that are fed at the same time as well
as the space between pages. Feeding stops if a double feed is detected.
Text Enhancement Modes
The scanner is equipped with the Advanced Text Enhancement mode to
enhance the text of documents with dark or uneven backgrounds, and the
Advanced Text Enhancement II mode to enhance the text when both the text and
background are light.
These modes may not work, depending on the type of document.
Color Drop-Out
The scanner is equipped with a Color Drop-Out function and a Color
enhancement function (Red) that enables you to specify a color for the scanner
to omit from the scanned image.
Skip Blank Page Function
The scanner is equipped with a Skip Blank Page function that enables you to
scan a document without storing images of blank pages, regardless of whether
each page of the document is two-sided or one-sided.
Prescan Function
The scanner is equipped with a Prescan function that enables you to adjust the
contrast and brightness of a prescanned image. The adjusted image is then sent
to the application software without the need to scan the document again.
Job Function
The scanner includes an operation panel to automatically scan and perform
operations. Up to nine operations, such as saving, printing, or mailing can be
registered. For information on the Job Function,see Chapter 5, "Job Registration
Tool Settings," on p.56.
Auto Start
The scanner is equipped with an auto start function, which enables scanning to
be automatically started when a document placed in the feeder is detected.
Compatible with Carbonless Duplicating Paper
The scanner is able to scan carbonless duplicating paper.

Sleep Mode
The scanner is designed to save energy by entering the sleep mode when it is
not scanning documents.
Bar Code Detection
The bar codes within documents can be detected by installing the optional bar
code module.

NOTE
Some functions may not be available, depending on the software you are using.
DR-3010CDR-3010C
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This section describes the name and function of each part. Make sure to read
this section and familiarize yourself with the parts of the scanner before using
the scanner.

Front View/Right-Side View

Front View (With the Document Feed Tray and Eject Tray Open)

Operation Panel

Back View

3. Names and Functions of Parts

Document Feeder
Load the Document. 
(See p.21.)

Power Indicator
This indicator lights blue 
when the scanner is
turned ON.

Document Feed Tray
Attach before placing 
documents.

Document Guides
Adjust these guides to fit the 
width of the document. (See 
p.22.)

Front Unit
Open when clearing paper jams 
and cleaning the scanner. (See
p.34 and p.67.)

Document Eject Area
Scanned documents are 
output here.

Extension Tray
Pull this tray out if the 
document hangs over the 
edge of the document feeder.

Extension Tray
Pull this tray out if the document hangs 
over the edge of the document eject 
tray.

Document Eject Tray
Open this tray when you 
want to stack output 
documents.

OPEN Button
Use to open the front unit.

Stop Key
Stops scanning.

Plus Key
Increases the job number on the display 
panel.

Display Panel
Displays the job numbers or the error 
codes. 

Minus Key
Reduces the job number to  
scan on the display panel. 

Start Key
Starts the job number to scan on the 
display panel. 

Error Codes Displayed:

: Displayed if the front unit is open.

: Displayed if a paper jam is detected.

: Displayed if a double feed is detected while scanning.

: Displayed if another type of error occurs.

For information resolving error codes, see "An Error Code Is Displayed on the 
Display Panel," on p.78.

Power Switch
This switch is used to turn the scanner 
ON and OFF. If you set the switch to 
‘AUTO’, the scanner is linked to be 
automatically turned ON/OFF in 
accordance with the power of the 
computer.

Theft Prevention Hole (Kensington)
Attach a key chain, etc. here to prevent 
the scanner from being stolen.

USB Connector
Connect a USB cable that supports 
Hi-Speed USB 2.0 to this 
connector.

Power Connector
Connect the supplied AC adapter to 
this connector.
DR-3010CDR-3010C
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Feed Selection Lever

Paper Eject Stopper

Feed Selection Lever
Use this lever to change the way 
documents are fed. Push it up to feed 
documents one at a time (Page Separation 
mode) (see p.22). Push it down to feed 
documents that are fastened together, such 
as invoices, without separating them 
(Bypass mode). (See p.24.)

Paper Eject Stopper
Use the paper eject stopper 
that corresponds to the 
length of the documents 
you want to scan.
DR-3010CDR-3010C
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To use the DR-3010C scanner, your computer must satisfy the following system 
requirements.

• Operating systems:
Microsoft Windows 2000 Professional SP4 or later
Microsoft Windows XP Professional SP3 or later
Microsoft Windows XP Home Edition SP3 or later
Microsoft Windows XP Professional x64 Edition SP2 or later
Microsoft Windows Vista Home Basic (32-bit Edition/64-bit Edition) SP1 or
later
Microsoft Windows Vista Home Premium (32-bit Edition/64-bit Edition)
SP1 or later
Microsoft Windows Vista Business (32-bit Edition/64-bit Edition) SP1 or
later
Microsoft Windows Vista Ultimate (32-bit Edition/64-bit Edition) SP1 or
later
Microsoft Windows Vista Enterprise (32-bit Edition/64-bit Edition) SP1 or
later

• Computer requirements:
CPU: Pentium 4 (3.2 GHz or faster)
Memory: 1 GB or more
Hard disk: 1 GB or more available space
CD-ROM drive
Hi-Speed USB 2.0
Monitor: Resolution of 1024 × 768 (XGA) or better recommended.

• An ISIS-compatible application or a TWAIN-compatible application that is 
compatible with the above operating systems.

1. Scanner System Requirements
DR-3010CDR-3010C
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IMPORTANT
• If you do not know the requirements for your computer system, contact the 

store where you purchased the computer or the manufacturer of the 
computer for more information.

• Use the latest USB 2.0 driver made available by Microsoft. For details, 
contact your local authorized Canon dealer.

• Use the USB interface provided as standard with your computer. However, 
normal operation is not guaranteed with all USB interfaces, even if present 
as standard equipment on the computer. For details, contact your local 
authorized Canon dealer.

• Scanning speeds are lower if your computer's standard USB interface is USB 
Full-Speed (equal to USB 1.1).

• The USB cable you are using should be the one originally included with the 
scanner.

• If the CPU, memory, interface card, and other specifications do not satisfy 
the installation requirements, the scanning speed may be greatly reduced 
and transmission may take a long time.

• Even if the computer satisfies the recommended specifications, the scanning 
speed may vary, depending on the specified scan settings.

• The ISIS/TWAIN drivers provided with the scanner do not necessarily operate 
on all ISIS or TWAIN-compatible applications. For details, contact your 
application software retailer.

This section describes how to install the required software.

The following software is included on the DR-3010C Setup disc.

• DR-3010C Driver/Job Registration Tool
The scanner driver for using the DR-3010C and the tool to register/set jobs.

• CapturePerfect 3.0
An ISIS compatible application developed for use with Canon document 
scanners.

NOTE
The Setup disc of the DR-3010C is configured as follows. Install the software using 
either Typical Installation or Custom Installation.

Setup Disc

2. Installing the Software

Menu Screen Typical Installation

Read Manuals Custom Installation
DR-3010CDR-3010C
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Follow the procedure below to install the software.

IMPORTANT
• Install the software before connecting the scanner to the computer.
• Log on to Windows as an Administrator.
• Close all other applications before installing the software.

1 Turn the power of the computer ON.

2 Insert the DR-3010C Setup disc into the CD-ROM drive of the computer.

3 Click [Typical Installation].

NOTE
When you select [Typical Installation], all of the displayed software and the User 
Manual will be installed automatically. If you want to reinstall only specific software 
that you have previously uninstalled, select [Custom Installation] and specify the 
software.

4  Click [Install].

5 Click [Next].

6 Read the license agreement → click [Yes] to accept it.

Software Installation
DR-3010CDR-3010C
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7 When the driver installation is complete, click [Finish].

8 Click [Next].

9 Read the license agreement → click [Yes] to accept it.

10 Confirm the installation location → click [Next].

11 When the CapturePerfect 3.0 installation is complete, click [Finish].

12 Click [Next].
DR-3010CDR-3010C
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13 When the User Manual installation is complete, click [Finish].

14 Click [Exit] to finish installing the software.

15 Remove the DR-3010C Setup disc from the CD-ROM drive.

Connect the scanner to the computer.

IMPORTANT
Before connecting the scanner to the computer, verify that the power switch of 
the scanner is OFF. If the power switch is in the ON position, push the switch to 
set it to OFF.

1 Verify that the power switch of the scanner is OFF ( setting).

2 Connect the power cord to the AC adapter.

Connecting the Scanner to the Computer
DR-3010CDR-3010C



17
3 Connect the plug of the AC adapter to the power connector on the back of 
the scanner.

120 V model

220-240 V model

4 Use the supplied USB cable to connect the scanner to the computer.
DR-3010CDR-3010C
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When you turn the computer and the scanner ON for the first time, the Plug and 
Play function of Windows recognizes the scanner and automatically installs the 
required device driver.

IMPORTANT
• If you turn the power OFF, wait at least 10 seconds before turning it ON 

again.
• If you will not be using the scanner for an extended period, you should 

disconnect the power cord from the AC outlet for safety.

The scanner will be recognized the first time it is connected to the computer.

1 Make sure that the scanner and computer are connected properly.

2 Press the power switch on the back of the scanner to turn the scanner ON 
( setting).

3 Windows automatically recognizes the DR-3010C as new hardware.

NOTE
If you set the power switch on the back of the scanner to ‘AUTO’, the scanner is 
linked to be automatically turned ON/OFF in accordance with the power of the 
computer.

Scanner Recognition

3. Turning the Power ON
DR-3010CDR-3010C
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The scanner can scan documents ranging in size from business cards and 
checks to LTR/A4. The document sizes that this scanner can scan are shown 
below.

Plain Paper
Size

Width: 1.97" to 8.5" (50 mm to 216 mm)
Length: 2.12" to 14.02" (53.9 mm to 356 mm)*

Paper weight
Page Separation mode: 14 to 54 lb bond (52 to 209 g/m2)

0.0024" to 0.01" (0.06 mm to 0.25 mm)
Bypass mode: 11 to 54 lb bond (40 to 209 g/m2)

0.002" to 0.01" (0.05 mm to 0.25 mm)

* You can scan documents up to 39.2" (1000 mm) long by setting the scanner 
to the Long Document mode. (See "Setting the Long Document Mode," on 
p.36.)

1. Documents
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IMPORTANT
A document must meet the following criteria to be scannable:

• When scanning multiple documents of different sizes, place the documents 
so that they cover the entire span of the feed rollers.

• It is recommended that documents larger than LTR/A4 paper are fed one 
sheet at a time.

• Scanning documents before the ink is dry can cause problems with the 
scanner. Always make sure that the ink on a document is dry before scanning 
it.

• Scanning documents that are written in pencil or similar material may make 
the rollers and scanning glass dirty, which can lead to smudges on the 
scanned image and transfer the dirt to subsequent documents. Always clean 
the internal parts of the scanner after scanning such documents.

• When scanning a two-sided document that is printed on thin paper, the 
image on the opposite side of each page may show through. In this case, 
adjust the scanning intensity in the application software and set the 
Preventing Bleed Through/Removing the Document Background function in 
the driver before scanning the document.

• It is recommended that thin documents are fed one sheet at a time.
• Scanning the following types of documents can cause a paper jam or 

malfunction. To scan such a document, make a photocopy of the document 
and then scan the photocopy.

Business Card
Size: 1.97" x 2.12" (50 mm x 53.9 mm) or larger
Paper weight: 140 lb bond (300 g/m2) 0.0138" (0.35 mm) or less

IMPORTANT
If a stack of business cards cannot be fed properly, reduce the number of cards 
in the stack.

Plastic Card
Size: 2.12" x 3.37" (53.9 mm x 85.5 mm) (ISO7810 standard)
Card thickness: 0.03" (0.76 mm) or less
Orientation: Horizontal feeding only
Embossed cards can be scanned.

NOTE
• Vertically placed cards may not be output properly, and cards that get jammed 

may be damaged when you remove them. Make sure to place cards in the 
proper orientation.

• Embossed cards may not scan correctly, depending on the type of 
embossment.

Wrinkled or creased 
documents

Extremely thin, 
translucent paper

Coated paper

Carbon paper

Documents with paper 
clips or staples

Torn documents

Curled documents

Documents with square 
holes punched
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Prepare the document feed tray according to the paper size and type.

The extension trays can be set to the size of the document you want to scan.

NOTE
• Documents can be scanned with the document eject tray closed.
• Open the document eject tray when you want to stack output documents.
• Use the extension tray when the document hangs over the edge of the main 

tray.

Use the document stopper that corresponds with the length of the document you 
want to scan.

Preparing the Trays

2. Preparing the Scanner
Preparing the Document Stopper
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There are two methods for feeding documents, the Page Separation mode and 
Bypass mode. Feeding pages continuously from a stack of documents placed in 
the feed tray is called the Page Separation mode. Feeding documents one sheet 
at a time or feeding documents consisting of multiple pages that are attached, is 
called the Bypass mode.
The document feed method can be changed by moving the feed selection lever.

1 Switch the feed selection lever to (Page Separation).

2 Adjust the document guides to fit the width of the document to be scanned.

3 Fan the pages of the document to be scanned, and then turn the document 
so that it is upside down.

CAUTION
When placing documents into the feed tray, take care not to cut your hands on 
the edges of the paper.

4 Place the document face down, with the top fed through the scanner first.

IMPORTANT
There is a load limit mark ( ) on the document guides. Do not stack 
documents higher than this mark (approximately 50 sheets of 20 lb bond (80 g/
m2) paper.) Doing so may cause a paper jam.

Feeding in the Page Separation Mode

3. Placing Documents
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5 Adjust the document guides to fit the width of the document.

NOTE
Before scanning, make sure that the document is not curled or creased, and that it 
is placed in the feed tray correctly. Scanning an improperly placed, curled, or 
creased document may damage the document or cause a paper jam.

6 Use the application software to start scanning.

CAUTION
• Before you place a document, check to make sure it does not contain paper 

clips, staples, or other small metal objects. These items may cause a fire or 
electrical shock, damage the document, or cause a paper jam or scanner 
malfunction.

• Do not wear loose clothing or jewelry that may get caught in the scanner 
while you are using it. This may result in personal injury. Be extra careful of 
neckties and long hair. If anything gets caught in the scanner, immediately 
disconnect the power cord from the power outlet to stop scanning.

IMPORTANT
• Always smooth out any folds or curls in your documents before placing them into 

the feeder. If the leading edge of a document is curled, it may cause a paper jam.
• If feeding stops due to a system error or paper jam while the scanner is 

scanning, resolve the problem, make sure that the scanned image of the last 
page that was successfully fed has been stored, and then resume scanning 
the remaining document pages.

• After you finish scanning, close the document feed tray and the document 
eject tray to prevent damage to the scanner while it is not being used.
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When scanning multiple page documents that are fastened together, such as 
invoices, place the documents so that the top (or the edge that is fastened 
together) is fed through the scanner first.

1 Switch the feed selection lever to (Bypass).

2 Adjust the document guides to fit the width of the document to be scanned. 
(See p.22.)

3 Place the document face down, with the top (or the edge that is fastened 
together) fed through the scanner first. (See p.22.)

4 Use the application software to start scanning.

IMPORTANT
• When placing documents that are fastened together, such as invoices,  place the 

fastened side of the document so that it is fed through the scanner first.
• After you finish scanning, close the document eject tray to prevent damage to the 

scanner while it is not being used.

1 Switch the feed selection lever to (Bypass).

IMPORTANT
When scanning cards, make sure to set the feed selection lever to (Bypass), 
and scan the cards one at a time.

2 Adjust the document guides to fit the width of the card to be scanned. (See 
p.22.)

Feeding in the Bypass Mode

Placing Cards
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3 Place the card horizontally, turn it upside down and face down, with the top 
fed through the scanner first.

CAUTION
Vertically placed cards may not be output properly, and cards that get jammed 
may be damaged when you remove them. Make sure to place cards in the 
proper orientation.

Folio Scan enables you to scan documents that are larger than LTR/A4 and, 
therefore, do not fit in the feeder. (The maximum size is 11" x 17"/A3.) To use 
the function, fold the document in half lengthwise and place it into the feeder. 
The DR-3010C will scan both sides and combine the scanned images into a 
single image.

IMPORTANT
• When folding the document, align the right and left sides and create a sharp, 

straight fold. Otherwise the document may jam or the image may not be aligned 
properly.

• The fold line itself will not be scanned. Keep this in mind if there is content 
such as photos, diagrams, or text that spans the fold.

• For Folio scanning, only the Bypass mode can be used. Place documents one 
at a time.

• Adjust the document guides to fit the width of the document. Otherwise, the 
image may scan as skewed or shifted.

Placing Folded Documents
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NOTE
• When scanning folded documents, switch the feed selection lever 

to (Bypass).
• When placing folded documents, place the document into the scanner so that 

the fold is on the right side. The side of the folded document facing you will 
become the right side of the combined image.

• When scanning folded documents, click the [Basic] tab in the Properties for 
Canon DR-3010C dialog box → select [Folio] from the Scanning Side drop-
down list → click [OK]. 
(See Chapter 4, "ISIS/TWAIN Driver Settings - Scanning Side Settings," on 
p.43.)

• The maximum size for the combined image is 11" x 17"/A3. When using the 
Folio function for an irregular document size, click the [Basic] tab in the 
Properties for Canon DR-3010C dialog box → select [Auto-detection] from the 
Page Size drop-down list → click [OK].

• Ultrasonic Double Feed Detection cannot be used when scanning folded 
documents.

When scanning with the DR-3010C, in addition to scanning from an application, 
you can also use the Job function to perform scanning by pressing the Start key. 
This section describes the procedures for scanning using the CapturePerfect 3.0 
software included with the scanner, scanning using the Job function, and other 
special scanning. For details on scan settings, see Chapter 4, "ISIS/TWAIN 
Driver Settings," on p.38.

This section describes how to start CapturePerfect 3.0, select the scanner, and scan 
documents.
The Scan Batch to File function is used here as an example.
For details, see the CapturePerfect 3.0 Operation Guide and CapturePerfect Online 
Help.

1 From the Windows task bar, click [Start] → [All Programs] → 
[CapturePerfect 3.0] → [CapturePerfect 3.0].

Scanning With CapturePerfect 3.0

4. Scanning Methods
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2 From the [Scan] menu, select [Select Scanner].

3 Select [CANON DR-3010C] → click [OK].

NOTE
If [CANON DR-3010C] is not displayed in the list of scanners, reinstall the
ISIS/TWAIN driver. (See Chapter 2, "Setup - 2. Installing the Software," on p. 13.)

4 Select the default page size from the Default Page size drop-down list → 
click [OK].

NOTE
• The Configure Device Settings dialog box is displayed only when you select 

[CANON DR-3010C] in the [Select Scanner] dialog box for the first time and 
click [OK], and when you click [Settings] for the [Select Scanner] dialog box.

• The settings here are applied when you click [Default] in the Properties for 
Canon DR-3010C dialog box.

• For a TWAIN driver, the default value is set to 'LTR' and cannot be changed.

5 From the [Scan] menu, select [Scanner Setting].

6 Set the scan settings → click [OK]. For more information on scan settings, 
see Chapter 4, "ISIS/TWAIN Driver Settings," on p.38.

7 Place your document. (See "3. Placing Documents," on p.22.)

8 From the [Scan] menu, select [Scan Batch to File].
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9 Specify the file name and the file type for saving the image data → click 
[Save] to start scanning.

10 When there are no more pages of the document to scan, scanning stops, 
and the Continue Scanning dialog box is displayed. Place the next 
document → click [Continue Scanning] to resume scanning, or click [Stop 
Scanning] to end scanning.

11After scanning is complete, select [Exit] from the [File] menu to quit 
CapturePerfect 3.0.

This section describes how to start the Job Registration Tool and how to scan 
with the Job Function. For more information, see Chapter 5, "Job Registration 
Tool Settings," on p.56.

Job Function

The job function is a function that registers jobs with [Job Registration Tool], and 
selects or executes the registered job number from the display panel. The 
conditions are registered for the job such as scanning condition, the format to save 
image data, the location to save the file.

1 From the Windows task bar, click [Start] → [All Programs] → [Canon DR-
3010C] → [Job Registration Tool].

NOTE
The Job Registration Tool is a TWAIN-compliant application program that installs 
with the ISIS/TWAIN driver, and is used for registering the jobs that are executed 
when the Start key is pressed.

Scanning with the Job Function
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2 Register the job. For information on registering jobs, see Chapter 5, "Job 
Registration Tool Settings," on p.56.

NOTE
• You can register jobs from No. 1 to No. 9.
• The following jobs are registered in the Registered Jobs by default:

No.1 Scan To Folder: Saves the scanned image to a specified folder in a 
specified format.
No.2 Scan To Mailer: Saves the scanned image to a specified format and 
attaches the file to an e-mail.

3 Click [Close] in the Job Registration Tool dialog box.

4 Place the document. (See "3. Placing Documents," on p.22.)

5 Press the Plus key or Minus key to select the job number of the Display 
Panel( ) → press the Start key( ). 

6 The Monitor for DR-3010C dialog box is displayed, and scanning starts.

7 When scanning is complete, the image data is sent with the specified 
conditions.

8 Click [Close] in the Monitor for DR-3010C dialog box.
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The Scan Panel is an application that is installed with the ISIS/TWAIN driver. It 
is displayed in the system tray when the DR-3010C driver is started.
If <Feeding Option> in the [Others] tab in the Properties for Canon DR-3010C 
dialog box is set to ‘Panel-Feeding’ or ‘Automatic Feeding’, the Scan Panel will 
appear when you start scanning.

Scan Panel Functions

The Scan Panel has the following functions.

Start button
If <Feeding Option> in the [Others] tab in the Properties for Canon DR-3010C 
dialog box is set to ‘Panel-Feeding’, clicking this button starts scanning. 
Stop button
Stops scanning.
Batch Separation button
After selecting [Panel] as the batch separation setting on the [Others] tab, if you 
enable batch separation from the application and start scanning, this button 
becomes active when scanning of the current document completes, and 
scanning stops. When clicked, this button depresses and remains depressed 
while scanning with batch separation continues, until scanning of the current 
document completes, and scanning stops. The button then returns to normal.

This section describes examples of settings that can be specified when scanning 
with the DR-3010C. For more information, see Chapter 4, "ISIS/TWAIN Driver 
Settings," on p.38, or the Help.

Enhancing the Text of a Document

You can set the scanning conditions to enhance the text of documents with dark 
backgrounds or documents with a light uniform background and low-contrast text.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[Advanced Text Enhancement] or [Advanced Text Enhancement II] from the Mode 
drop-down list → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Scan Mode Settings," on p.40.

Scanning Documents That Include Both Color and Black-and-White Pages

You can set the scanning conditions to detect whether the document to scan is in 
color or black and white, and save it as a color image or black and white image 
accordingly.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[Auto Color Detection] from the Mode drop-down list → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Auto Color Detection," on p.41.

Using the Scan Panel Special Scanning

Text EnhancementDocument to Scan Black and White Mode
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Scanning Different Sized Documents Together

You can set the scanning conditions to scan different sized documents together, 
such as LTR and LGL documents, while detecting the correct size of the document.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[Auto-detection] from the Page Size drop-down list → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Paper Size Settings," on p.42.

IMPORTANT
When scanning different size documents together, align the center of the 
documents with the center of the feed roller.

Skipping Blank Pages

You can set the scanning conditions to determine whether a scanned image is a 
blank page, and not to save the image if it is blank.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[Skip blank page] from the Scanning Side drop-down list → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Scanning Side Settings," on p.43.

Scanning (Single-Sided) 11" x 17"/A3 Documents

You can set the scanning conditions to scan both sides of an 11" x 17"/A3 
document folded in half to be combined as a single image.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[Folio] from the Scanning Side drop-down list → click [OK].
For more information on setting the scanning conditions, see "Placing Folded 
Documents," on p. 25, and Chapter 4, "ISIS/TWAIN Driver Settings - Scanning Side 
Settings," on p.43.

Auto Page Size Detection

Feed Roller

Monthly Report

Monthly Report

Monthly Report

Monthly ReportMonthly Report

This blank page will be skipped
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Deskewing Documents

You can set the scanning conditions to detect slanted document pages and 
straighten the scanned images.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select the 
[Deskew] check box → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Correcting Image Skewing," on p.44.
Documents exceeding the width of the sensor may become damaged. Also, the 
scanned image may not be output correctly.

Moire Reduction

You can set the scanning conditions to reduce the moire effect (a shimmering, 
wavy pattern) that often appears when scanning color documents or scanning in 
grayscale.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → select 
[High Quality Moire Reduction] from the Moire Reduction drop-down list → click 
[OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Moire Reduction," on p.45.

Correcting the Text Orientation of Documents

You can set the scanning conditions to detect the text orientation in scanned 
images, and rotate the images in 90° increments as needed to normalize the 
orientation.
Click the [Image processing] tab in the Properties for Canon DR-3010C dialog box 
→ select the [Text Orientation Recognition] check box → click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Text Orientation Detection," on p.50.

Reducing Bleed Through for Thin Documents and Documents with Dark 
Back Sides

You can set the scanning conditions to reduce bleed through when scanning thin 
document pages and those with dark content on the back side, or to remove the 
background from document images.
Click the [Image processing] tab in the Properties for Canon DR-3010C dialog box 
→ select the [Prevent Bleed Through / Remove Background] check box → click 
[Setting] → adjust the Removal level setting → click [OK] → [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Preventing Bleed Through/Removing the Document 
Background," on p.50.

Deleting Borders and Ruled Lines of a Specified Color (Red/Green/Blue)

You can set the scanning conditions to omit borders and ruled lines of a specified 
color (red, green, or blue) from the scanned image. However, this function is only 
available when scanning in black-and-white.
Click the [Image processing] tab in the Properties for Canon DR-3010C dialog box 
→ select the colors to omit from the Front and Back drop-down lists →
click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Omitting a Specific Color," on p.51.

Deskew OnDeskew Off

Color Drop-out (Red)Document to Scan
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Enhancing the Red color for Black-and-White Scanning

You can set the scanning conditions to enhance the color red when performing 
black-and-white scanning.
Click the [Image processing] tab in the Properties for Canon DR-3010C dialog box 
→ select [Red Enhance] from the Front and Back drop-down lists →
click [OK].
For more information on setting the scanning conditions, see Chapter 4, "ISIS/
TWAIN Driver Settings - Enhancing the Red Color," on p.51.

Creating Smaller Files

You can set the scanning conditions to save the scanned image as a PDF file with a 
high-compression rate, so that the file size is smaller.
Select [PDF File] from the [Options] menu in CapturePerfect 3.0 → click [High 
compression] in <Mode> → click [OK].
For more information on setting the scanning conditions, see the CapturePerfect3.0 
Operation Guide.

Saving the Text Data of Documents as Search Keywords

You can set the scanning conditions to convert the text information of a document 
into text data when creating a PDF file, to be used when searching the text on a 
computer.
Select [OCR Settings] from the [Options] menu in CapturePerfect 3.0 → select the 
[Enable] check box → select the language to apply OCR from the Language for 
OCR drop-down list → click [OK].
For more information on setting the scanning conditions, see the CapturePerfect3.0 
Operation Guide.

Specifying Security Settings for PDF Files

You can specify security settings to restrict the viewing, printing, and editing of 
PDF files created with CapturePerfect 3.0.
For more information on specifying security settings, see the CapturePerfect3.0 
Operation Guide.

This section provides examples of settings when scanning with the DR-3010C. 
Refer to these examples when specifying ISIS/TWAIN driver settings. For 
descriptions of particular setting items, see Chapter 4, "ISIS/TWAIN Driver 
Settings," on p.38.

Scanning Both Sides of Pages

• To scan both sides of pages
Select [Duplex] from the Scanning Side drop-down list.

Scanning Non-Standard Size Documents

• To scan irregular size documents
If irregular size documents are scanned with a standard size selected for the 
Page Size setting, black areas may appear around the scanned document 
image. To scan irregular size documents, select [Auto-detection] from the Page 
Size drop-down list. The page size is then detected automatically.

• To register an irregular page size for scanning documents
An irregular document size not already registered as a page size selection can 
be saved as a custom page size.
(See "Adjusting the Scan Area," on p.45.)

• To scan only part of the document page
You can specify the scanning area. However, you cannot set the scan area when 
[Auto-detection] is selected from the Page Size drop-down list.
(See "Adjusting the Scan Area," on p.45.)

Scanning Multiple Batches as One Document

• To scan a document that has too many pages to be loaded all at once as 
separate batches
Select [Automatic Feeding] from the Feeding Option dialog box. When this 
option is selected, the scanner detects documents and starts scanning as they 
are loaded, so continuous scanning is possible by loading the document 
batches repeatedly.
If you select [Panel-Feeding] from the Feeding Option dialog box, scanning 
does not start until you press the Scan button. This is useful if you want to 
straighten documents after you have placed them in the scanner.

5. Practical Examples
DR-3010CDR-3010C



34
• To create separate files for each batch of documents during continuous 
scanning
Select [Automatic Feeding] or [Panel-Feeding] from the Feeding Option dialog 
box → select [Auto] from the Batch Separation drop-down list (only for the ISIS 
driver).

• To scan a batch of documents one page at a time
Select [Automatic Feeding] or [Panel-Feeding] from the Feeding Option dialog 
box, and scan the documents one page at a time. After each page is scanned, 
the Scan Panel dialog box is displayed. If you selected [Automatic Feeding], the 
scanner detects when the next document is placed and continues scanning. If 
you selected [Panel Feeding], press the Scan button after placing the next 
document to continue scanning.

Prescan

• To confirm images before scanning
Select the [Prescan] check box. The Prescan window is displayed when 
scanning starts.
(See "Prescan," on p.54.)

Registering Settings

• Registering Your Settings
Register a name for your settings in the user preferences. When you want to 
recall your settings later, select the name of your registered user preferences, 
and they will be reflected in the dialog boxes.
(See "Registering Scanning Conditions," on p.55.)

By using the Job function or the Job Scan function in CapturePerfect 3.0, you 
can register scanning conditions and methods for processing scanned image 
files as jobs, and scan by selecting a job.

If a paper jam or double feed is detected while scanning, the following error 
code is displayed on the display panel of the scanner and the scanning stops.

CAUTION
When removing documents, take care not to cut your hands on the edges of the 
paper.

1 Remove any documents that have been left in the eject tray.

6. Handling Paper Jams/Double Feed Detection

Error Code for a 
Paper Jam

Error Code for a 
Double Feed 
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2 Press the OPEN button ( ) while pulling the front unit open ( ). The 
error code on the display panel changes to "C."

NOTE
The "C" error code is displayed on the display panel if the front unit is open.

3 Remove the document from the document feeding side or document 
ejecting side.

IMPORTANT
Make sure to pull the document out carefully, without applying too much force. If 
the jammed paper tears while you are pulling it out, make sure to remove any 
remaining pieces from inside the scanner.

4 Close the front unit by gently pushing it up on both sides until it clicks into 
place. Make sure that the front unit is completely closed by pushing until 
you hear a click and the error code on the display panel is no longer 
displayed.

NOTE
• After removing the jammed paper, check to see if the last page was scanned 

correctly, and then continue scanning.
• If a paper jam occurs when [Rapid recovery system] is enabled in the [Others] 

tab in the Properties for Canon DR-3010C dialog box, the image data of the 
document is not saved and scanning stops. This allows you to continue 
scanning from the document that caused the paper jam after the paper jam is 
fixed.
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The length of documents that can be scanned with the DR-3010C is normally 
14.02" (356 mm), but you can scan documents up to 39.2" (1,000 mm) long by 
setting the scanner to the Long Document mode.

IMPORTANT
When scanning in the Long Document mode, click the [Basic] tab in the 
Properties for Canon DR-3010C dialog box → select [Auto-detection] from the 
Page Size drop-down list → click [OK]. This allows the scanner to detect and 
scan documents up to 39.2" (1,000 mm) long. Note the following when using the 
Long Document mode: 
• When scanning long documents, make sure to set the feed selection lever to 

(Bypass), and scan the documents one at a time.
• When scanning in the Long Document mode, if the document is placed on 

the scanner in a skewed position, it may hit the edges of the feeding area 
and be damaged. Be careful to place the document so that it is not skewed.

• When scanning in the Long Document mode, paper jam detection may react 
slowly, resulting in damage to the document. Be careful to avoid paper 
jams.

1 From the Windows task bar, click [Start] → [Control Panel].

2 If the Control Panel is displayed with the Category View, click [Printers and 
Other Hardware] in the working field → click [Scanners and Cameras].
If the Control Panel is displayed with the Classic View, double-click 
[Scanners and Cameras].

Control Panel (Category View) Printers and Other Hardware

Control Panel (Classic View)

3 Right-click [CANON DR-3010C USB] → click [Properties].

Setting the Long Document Mode

7. Other Functions
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4 Click the [Maintenance] tab → click the [Long Document mode
(1,000 mm)] radio button.

5 Click [Apply] → [OK].

6 Turn the scanner OFF, and then ON again.
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To use the DR-3010C with an ISIS/TWAIN-compliant application, the
DR-3010C must first be selected as the scanner to be used.
This section describes how to select the scanner using CapturePerfect 3.0.

1 From the Windows task bar, click [Start] → [All Programs] → 
[CapturePerfect 3.0] → [CapturePerfect 3.0].

2 From the [Scan] menu, select [Select Scanner].

3 Select [CANON DR-3010C] → click [OK].

1. Before Using the Scanner
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NOTE
If [CANON DR-3010C] is not displayed in the list of scanners, reinstall the ISIS/
TWAIN driver. (See Chapter 2, "Setup - 2. Installing the Software," on p. 13.)

4 Select the default page size from the Default Page Size drop-down list → 
click [OK].

NOTE
• The Configure Device Settings dialog box is displayed only when you select 

[CANON DR-3010C] in the [Select Scanner] dialog box for the first time and 
click [OK], and when you click [Settings] for the [Select Scanner] dialog box.

• The settings here are applied when you click [Default] in the Properties for 
Canon DR-3010C dialog box.

• For a TWAIN driver, the default value is set to 'LTR' and cannot be changed.

5 From the [Scan] menu, select [Scanner Setting].

The Properties for Canon DR-3010C dialog box is displayed.

The Properties for Canon DR-3010C dialog box is displayed when you select 
[Scanner Setting] from the [Scan] menu in CapturePerfect 3.0.
It consists of four tabs: Basic, Brightness, Image processing, and Others.
Specify the settings on each tab as necessary to set the scanning conditions.
For details on each setting, also refer to the Help.

[OK] button
Confirms the settings and closes the dialog box.

[Scan] button
For a TWAIN-compatible application that can perform scanning from the 
Properties for Canon DR-3010C dialog box, the [Scan] button is displayed 
instead of the [OK] button. Press [Scan] to scan with the displayed settings.

[Cancel] button
Cancels the settings and closes the dialog box.

[Default] button
Returns the settings to their default values.

[Help] button
Displays Help for the currently open tab or dialog box.

2. ISIS/TWAIN Driver Properties Dialog Box
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NOTE
If you are using a TWAIN driver, the two extra settings below are displayed on the 
[Basic] tab and [Image processing] tab. Refer to the Help for details.

-[Basic] tab: Scan options
-[Image processing]: Black/white inversion 
 

This section describes the procedure for setting the scan mode to suit your 
needs.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the scanning mode from the Mode drop-down list → click [OK].

NOTE
• You can select the following modes, according to the type of document you 

want to scan. Note that some functions may be restricted, depending on the 
mode settings.
- [Auto Color Detection]

Whether a document is black-and-white or color is detected before the 
scanned image is saved.

When [Auto Color Detection] is enabled, the [Setting] button is enabled 
for opening the Auto Color Detection dialog box, where you can make 
settings affecting how color documents are scanned, and select which 
scanning mode to use for black-and-white documents.
Depending on the application program, the operation may become 
unstable when [Auto Color Detection] is enabled. In this case, [Auto 
Color Detection] should be disabled.
For details, See "Auto Color Detection," on p.41.

- [Black and White]
Use this mode to scan text and line drawing documents as black-and-white 
(binary) images.

- [Error Diffusion]
Use this mode to scan documents containing photos as black-and-white 
(binary) images.

- [Advanced Text Enhancement]
Use this mode to scan documents with a dark or non-uniform (pattern) 
background.

If the background is uniform, it is removed where it surrounds the text.
If the background is non-uniform, such as a pattern, it is processed to 
enhance text readability.

- [Advanced Text Enhancement II]
Use this mode to scan documents with a light uniform background and 
low-contrast text.

The background in tight spaces around text may not be removed.
Documents with low-contrast text can be made more readable by 
adjusting [Contrast] on the [Brightness] tab.
If the background is non-uniform, such as a pattern, the background 
remains visible in the scanned image, and text may be hard to read.

- [256-level Gray]
Scans documents containing photos as grayscale images.

- [24-bit Color]
Scans documents containing color photos as full-color images.

Scan Mode Settings
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• The following tab functions are partially disabled according to the selected 
mode.

: Available for setting
−: Not available for setting, or automatically set

This section describes the procedure for setting the scanner to automatically 
detect whether a document is in color or black-and-white when scanning.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select [Auto Color Detection] from the Mode drop-down list → click 
[Setting].

2 Specify the various settings in the Auto Image Type Detection Settings 
dialog box → click [OK].

NOTE
The settings you can specify are as follows.
- [Color Saturation/Proportion of Color]

Normally scan with the default values (Color Saturation: 2, Proportion of Color: 
2). Change the settings when you want to scan a color document as a black-
and-white document.

Settings Tab

Scanning Mode

Basic Image processing Others

Auto Color Detection − − − −

Black and White

Error Diffusion

Advanced Text Enhancement −

Advanced Text Enhancement II − −

256-level Gray −

24-bit Color − −
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Color Saturation: Adjust the setting towards <High> when you want to scan a 
color document with low color saturation as a black-and-white document.
Proportion of Color: Adjust the setting towards <High> when you want to scan 
a color document with a low proportion of color as a black-and-white 
document.

- [Mode in case of binary]
Select the scanning mode when a page is detected as black-and-white.

- [Brightness]
This setting adjusts the brightness when [Advanced Text Enhancement] or 
[Advanced Text Enhancement II] is selected from the Mode drop-down list. For 
other modes, the brightness is set from the [Brightness] tab.

- [Contrast]
This setting adjusts the contrast when [Advanced Text Enhancement II] is 
selected from the Mode drop-down list. For other modes, the contrast is set 
from the [Brightness] tab.

This section describes the procedure for selecting the size for scanning.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the page size from the Page Size drop-down list → click [OK].

NOTE
• Click [Auto-detection] to scan the following kinds of documents: 

- Documents of undetermined size
- Documents including mixed page sizes 
- When using the Long Document mode (See "Setting the Long Document 

Mode," on p.36.)
• When [Auto-detection] is selected, the Area setting from the Scan Area dialog 

box is disabled.
• Depending on the application, the operation may become unstable when [Auto-

detection] is enabled. In this case, [Auto-detection] should be disabled.

Paper Size Settings
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This section describes the procedure for setting the resolution for scanning.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the resolution for scanning from the Dots per inch drop-down list → 
click [OK].

NOTE
• Higher resolutions provide clearer images, but produce larger files.
• When the selected resolution is 300 dpi or less, the Moire Reduction setting is 

automatically enabled to allow reduction of the moire effect (a shimmering, 
wavy pattern) in scanned images.

This section describes the procedure for setting the page side settings for 
scanning.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the page side to scan from the Scanning Side drop-down list → click 
[OK].

NOTE
• Specify one of the settings below according to the page side setting you want to 

use.
- [Simplex]

Scan only the front side of documents loaded into the feeder.
- [Duplex]

Scan both sides of documents.

Scan Resolution Settings Scanning Side Settings
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- [Skip blank page]
As each document page is scanned, the scanner detects whether it is blank, and 
if so, the image is not saved.

Selecting [Skip blank page] enables the [Setting] button, which opens the 
Blank Skip Setting dialog box.
Adjust the Content density setting in the Blank Skip Setting dialog box if 
blank pages are not skipped, or if non-blank pages are skipped.

The Content density setting should be adjusted according to the document 
content, so that only blank pages are skipped: increase the setting if they 
are not skipped, and decrease the setting if non-blank pages are skipped.
The Skip Blank Pages function may not work properly if the Custom setting 
is enabled in the Gamma Settings dialog box.
If a scanning side setting (simplex or duplex) is specified in the application 
settings, select [Simplex].

- [Folio]
Documents that are normally folded in half are scanned on both sides and 
composed into one image.

You cannot select [Folio] if you click [Patchcode] from the Batch Separation 
drop-down list in the [Others] tab.

This section describes the procedure for setting the scanner to detect slanted 
document pages and straighten the scanned images.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the [Deskew] check box → click [OK].

NOTE
Deskewing may not work properly, or cause part of the image to be lost, depending 
on the document.

Correcting Image Skewing
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This section describes the procedure for setting to reduce the moire effect (a 
shimmering, wavy pattern) that may appear when scanning color documents or 
scanning in grayscale.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select [High Quality Moire Reduction] from the [Moire Reduction] 
drop-down list → click [OK].

NOTE
• The [High Speed Moire Reduction] is displayed only when a resolution of 240 

dpi or less is selected from the Dots per inch drop-down list.
• The [High Quality Moire Reduction] is displayed only when a resolution of 300 

dpi or less is selected from the Dots per inch drop-down list. When a resolution 
higher than 300 dpi is selected from the Dots per inch drop-down list, [High 
Quality Moire Reduction] cannot be selected.

• Select one of the following according to the resolution you have set:
- [None]

Do not perform moire reduction.
- [High Speed Moire Reduction]

This mode prioritizes speed, and generates an image of the specified resolution 
from an image scanned at 300 dpi.

- [High Quality More Reduction]
This mode prioritizes image quality, and generates an image of the specified 
resolution from an image scanned at 600 dpi. The image quality is higher, but 
the scanning speed decreases.

This section describes the procedure for scanning part of a document image.

1 Click the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
click [Area] → click [OK].

NOTE
The Scan Area dialog box enables you to define the area of the document page to 
scan on a selected page size, and register nonstandard document page sizes.
The Scan Area dialog box is different for ISIS and TWAIN drivers. For the TWAIN 
driver, one of two dialog box types is displayed, depending on the application 
program used.

Scan Area Dialog Box (ISIS Driver)

Moire Reduction Adjusting the Scan Area
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Scan Area Dialog Box (TWAIN Driver)
This dialog box appears with application programs that display the Scan button 
in the Properties dialog box.

The Area window and Preview button are not displayed when using applications 
like the Job Registration Tool that display the OK button in the Properties dialog 
box.

Page Size
This setting is linked to the Page Size setting, for selecting the size of document 
pages to scan. 

Clicking [Custom] opens the Custom Page Size dialog box, where 
nonstandard page sizes can be registered as custom page sizes.

Area
Select the area to be scanned. Area settings here are overridden in the following 
cases:

When [Auto-detection] is selected from the Page Size drop-down list
When [Text Orientation Recognition] is enabled in the [Image processing] 
tab
When [Deskew] is enabled in the [Basic] tab, the specified area may be 
displaced when scanning.

Area Window
The size indicated for the Area window corresponds to the page size setting, 
and the area within the panel indicates the current scanning area.

The scanning area can be adjusted by dragging the handles bordering the 
Area window with your mouse.
When you use CapturePerfect, the last scanned image appears in the Area 
window.

Margin
This control adjusts the top, bottom, left, and right margins around the 
scanning area so that you can expand the scanning area to include the edges of 
a document, or reduce it to avoid black frames around scanned images.

If the edges of documents are missing from scanned images, move the 
slider to the right to expand the scanning area.
To eliminate the black frame around scanned images, reduce the scanning 
area by moving the slider to the left.
The measurement units for margins are determined by the Unit setting. 

Preview Button (TWAIN driver only)
Click [Preview] to scan one document page and display its preview image in the 
Area window.
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This section describes the procedure for adjusting the brightness and contrast 
for scanning.

1 Click the [Brightness] tab in the Properties for Canon DR-3010C dialog box 
→ adjust the [Brightness] slider and [Contrast] slider to adjust the 
brightness and contrast for scanning → click [OK].

NOTE
• The settings you can specify are as follows:
- [Brightness]

Adjusts the brightness of images to be scanned.
If images are too dark or if text on the back bleeds through, drag the slider 
to the right to increase the brightness.
If images are too light, drag the slider to the left to decrease the brightness.

- [Contrast]
Adjusts the contrast of images to be scanned.

- [Used the Back Side Brightness] Check Box
If the brightness of the front and back pages of the document are different, 
select this check box to adjust only the brightness on the back side.

- [Used the Back Side Contrast] Check Box
If the contrast of the front and back pages of the document are different, select 
this check box to adjust only the contrast on the back side.

• The availability of brightness and contrast settings are as follows, according to 
the setting selected from the Mode drop-down list in the Basic tab.

: Available for setting
 −: Not available for setting, or automatically set
7

Brightness/Contrast Adjustment

Scanning mode Brightness Contrast Back Side 
Brightness

Back Side 
Contrast

Black and White

Error Diffusion

Advanced Text Enhance-
ment − − −

Advanced Text Enhance-
ment II − −

256-level Gray

24-bit Color

Auto Color Detection
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This section describes the procedure for adjusting the gamma level for scanning 
documents.

1 Click the [Brightness] tab in the Properties for Canon DR-3010C dialog box 
→ click [Gamma] → click [OK].

2 Select the [Custom] check box in the Gamma Settings dialog box → 
specify the settings as necessary → click [OK] → [OK].

NOTE
• When the [Custom] check box in the Gamma Settings dialog box is selected, all 

settings in the [Brightness] tab are set automatically.

• The settings you can specify are as follows:
- Select

Select the side and color for the custom setting.
The color bar and color of the sample image are changed to show the 
specified color.

- Input method
Select the setting method for gamma correction.

- [Factor]
Move the slider to the left or right to adjust the gamma correction factor 
between 0.2 and 5.0.

The gamma correction value, Gamma Curve Graph, and sample image color 
are interlinked.
Clicking a point in the Gamma Curve Graph with your mouse changes the 
gamma curve and color of the sample image to match that point.
You can also move the gamma curve by dragging it with the mouse.

- [Freehand]
The output value for a particular input value in the gamma table can be specified 
with the mouse.

Click any point in the Gamma Curve Graph to set that point as an output 
value.
Drag the mouse on the Gamma Curve Graph to set the output value 
according to the mouse movement.

- [Import]
Clicking this button loads gamma table data (*.pxg file) that was previously 
stored with the Export button.

Imported gamma data is reflected in the Gamma Curve Graph.
- [Export]

Clicking this button exports the custom gamma curve settings as a gamma 
table file (*.pxg).

Gamma Curve Settings
DR-3010CDR-3010C



49
This section describes the procedure for adjusting the contours of the scanned 
image.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → adjust the Edge emphasis slider to adjust the contours of the 
scanned image → click [OK].

NOTE
Move the slider toward <Soft> to soften the image contours, or toward <Sharp> to 
sharpen the image contours.

This section describes the procedure for rotating the orientation of the scanned 
image.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → select the angle to rotate the image from the Document 
Orientation drop-down list → click [OK].

NOTE
The scanned image will be rotated as follows, according to the orientation of the 
placed document and the specified angle.

Image Contour Adjustment Image Rotation

270 degrees

Document: 
face down

Document Orientation
(clockwise)

Scanned Image

0 degrees 90 degrees 180 degrees
DR-3010CDR-3010C



50
This section describes the procedure for automatically correcting the orientation 
of an output image by detecting the direction of the text when scanning.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → select the [Text Orientation Recognition] check box →  click 
[OK]. 

NOTE
• When the [Text Orientation Recognition] check box is selected, the Image 

Rotation and area settings in the Scan Area dialog box are disabled.
• Some application programs do not support text orientation recognition. Please 

disable [Text Orientation Recognition] if your application program operates 
abnormally when it is enabled.

This section describes the procedure for setting to reduce bleed through when 
scanning thin document pages and pages with dark content on the back side, or 
to remove the background from document images.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → select the [Prevent Bleed Through / Remove Background] 
check box → click [Setting].

2 Adjust the [Removal level] slider to set the level of bleed through 
prevention or background removal → click [OK] → [OK].

Text Orientation Detection Preventing Bleed Through/Removing the Document 
Background
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This section describes the procedure for setting to omit borders and ruled lines 
of a specified color (red, green, or blue) from the scanned image.

NOTE
If you select [24-bit Color] or [Auto Color Detection] from the Mode drop-down list 
in the [Basic] tab, you cannot specify this setting.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → select the color to omit from the Front and Back drop-down 
lists under <Color drop-out> → click [OK].

NOTE
You can specify different settings for the front and back side of the document.

This section describes the procedure for setting the scanner to enhance the 
color red when performing black-and-white scanning.

NOTE
If you select [24-bit Color] or [Auto Color Detection] from the Mode drop-down list 
in the [Basic] tab, you cannot specify this setting.

1 Click the [Image processing] tab in the Properties for Canon DR-3010C 
dialog box → select [Red Enhance] from the Front and Back drop-down 
lists under <Color drop-out> → click [OK].

NOTE
You can set specify different settings for the front and back side of the document.

Omitting a Specific Color Enhancing the Red Color
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This section describes the procedure for setting the system recovery method 
used by the scanner when document feeding stops due to a paper jam or other 
error during scanning.

1 Click the [Others] tab in the Properties for Canon DR-3010C dialog box → 
select the [Rapid recovery system] check box → click [OK].

NOTE
If you select [Rapid recovery system] and a paper jam or other error causes 
document feeding to stop while scanning, scanning stops without sending an error 
notification to the application program. After you clear the paper jam or resolve the 
error, you can resume the normal scanning operations.

This section describes the procedure for setting the scanner to stop document 
feeding when double feeding of document pages is detected.

1 Click the [Others] tab → select the [Detect by Length] or [Detect by 
Ultrasonic] check box under <Double Feed Detection> according to the set 
of documents → click [OK].

NOTE
[Detect by Length]

This detection method is effective when scanning documents of the same size. 
It detects double-feeding when a document is 2.0" (50 mm) longer or 2.0" (50 
mm) shorter than the standard length (the length of the first document). 
Feeding is stopped when a double-feed is detected.

[Detect by Ultrasonic]
This detection method is effective when scanning documents of different sizes. 
It uses ultrasonic waves to detect the gap between documents when more than 
two sheets of paper are fed at the same time. Feeding is stopped when a 
double-feed is detected.

• The two detection methods can be used at the same time.
• When the documents overlap by less than 2.0" (50 mm) or are stuck together 

due to static electricity, double-feeding may not be able to be detected correctly 
using Detect by Ultrasonic.

• The [Detect by Ultrasonic] check box cannot be selected when scanning folded 
documents.

Rapid System Recovery Double Feed Detection
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This section describes the procedure for selecting the method for feeding 
documents.

1 Click the [Others] tab in the Properties for Canon DR-3010C dialog box → 
select the document feeding method from the Feeding Option
drop-down list → click [OK].

NOTE
• Details of each feeding method are indicated below.
[Standard Feeding]

This feeding method is good for scanning small batches of documents that are 
placed one batch at a time. Scanning stops when the documents have been 
scanned.

[Panel-Feeding]
This feeding method is good for scanning batches of documents of different 
sizes. After placing the documents, press the Start button on the Scan Panel to 
start scanning, and press the assigned Stop button to stop scanning. 

When scanning documents with different sized pages, after placing the 
documents, you can adjust the document guide position. 

[Automatic Feeding] 
This feeding method is good for scanning batches of the same sized 
documents. Scanning starts when the scanner detects the placed documents, 
and stops when you press the Stop button. 

When [Automatic Feeding] is selected, the Setting button is enabled to 
allow setting the delay time from when a placed document is detected to 
when scanning starts. The delay time can be set from 0 to 60 seconds.

Batch Separation (ISIS driver only)
When the separation timing to use when scanning starts with batch separation 
enabled in the application. (If [Standard Feeding] is selected, batch separation 
is disabled.)

[Auto]
Document batches are separated automatically.

[Panel]
Document batches are separated when [Batch Separation] on the Scan Panel is 
pressed. (See "Using the Scan Panel," on p.30.)

Feeding Options
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This section describes the procedure for checking a scanned image and 
adjusting the brightness and contrast accordingly.

1 Click the [Others] tab in the Properties for Canon DR-3010C dialog box → 
select the [Prescan] check box → click [OK].

2 From the [Scan] menu, select [Scan Batch to File]. Specify the location, file 
name, and file format to save the image → click [Save] to start scanning.

When scanning is complete, the Prescan window is displayed.

3 Check the preview image displayed in the Prescan window → adjust 
[Brightness] and [Contrast] as necessary using the sliders or up/down 
buttons → click (Start) to save the scanned image.

NOTE
The Prescan window is for scanning after adjusting the brightness and contrast, 
according to the scanned results of the first document. You can enlarge the image 
displayed in the Prescan window. (Left-click the image displayed in the window to 
enlarge it, and right-click the image displayed in the window to reduce it.)
If you change the brightness and contrast values, the image displayed in the 
window reflects these new values. Click the Start button to start scanning with the 
adjusted brightness and contrast. Click the Stop button to stop scanning.

Prescan
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This section describes the procedure for registering specified scanning 
conditions.

1 Specify the scanning conditions as necessary in the [Basic], [Brightness], 
[Image processing], and [Others] tabs in the Properties for Canon
DR-3010C dialog box.

2 Click the [Basic] tab → click [Save].

3 In the Save User Preference dialog box, enter a name in the [Save user 
preference as] text box → click [OK].

This section describes the procedure for checking the version of the ISIS/TWAIN 
driver you are currently using.

1 Click the [Basic] tab in the Properites for Canon DR-3010C dialog box → 
click [About].

2 Check the content of the About dialog box → click [OK] → [OK].

Registering Scanning Conditions Checking the Version
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Chapter 5 Job Registration Tool Settings

1. Starting the Job Registration Tool................................................ 56

2. Job Registration Tool Settings Dialog Box ...................................... 57

Job Registration Tool Dialog Box........................................................... 57
New/Editing Dialog Box ......................................................................... 57
Setting the Launcher ............................................................................. 61
Admin Dialog Box.................................................................................. 63
Printing Registered Jobs ....................................................................... 65

The Job Registration Tool is a TWAIN-compliant application program that installs 
with the ISIS/TWAIN driver, and is used to register jobs that can be executed by the 
operation panel. Use the following procedure to start the Job Registration Tool.

1 From the Windows task bar, click [Start] → [All Programs] → [Canon DR-
3010C] → [Job Registration Tool].

1. Starting the Job Registration Tool
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The Job Registration Tool Settings dialog box provides access to the New/
Editing and Admin dialog boxes. The New/Editing dialog box provides access to 
the function setting dialog boxes.

This dialog box appears when the Job Registration Tool is started from the 
Windows Start menu.

Registered Job List
Displays the number of the registered jobs and their currently assigned settings. 
Click the job from the currently registered job list → select [New/Editing] from the 
[Editing] menu to display the New/Editing dialog box.

[Close] Button
Closes the Job Registration Tool dialog box.

The New/Editing dialog box appears when you click a job in the Job Registration 
Tool dialog box or click [New/Editing] from the [Editing] menu.
The New/Editing dialog box appears as follows, depending on the function settings 
registered to the job.

Save as File

Print

Attach to E-mail

Launcher

Job Registration Tool Dialog Box

2. Job Registration Tool Settings Dialog Box New/Editing Dialog Box
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Settings Common to Each Function

Job Number [No. 1 to No. 9]
Displays the selected job number. Settings are registered to the job with the 
displayed number.

[Job title]
Enter the job title to be displayed for [Job title] in the Job Registration Tool 
dialog box.

Job titles may consist of up to 40 alphanumeric characters.

[Function]
Select the function to set for each job.

When you change functions, the New/Editing dialog box is changed.

Scanner setting
When the [Save as file], [Print], or [Attach to E-mail]  is selected from the 
Function drop-down list, scanner settings are enabled, and you can press  
[Setting] to specify scanner settings.

NOTE
For more information on the scanner settings, see Chapter 4, "ISIS/TWAIN Driver 
Settings," on p.38.
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Settings to Save Image Files

[Save Image] Check Box
This check box appears when [Attach to E-mail] is selected from the Function 
drop-down list. Select this check box to save scanned images to a folder that 
you specify.

[Save to My Pictures folder] Check Box
Saves image files to [My Pictures] in the [My Documents] folder.

When this check box is not selected, [Save in folder] and [Access setting] 
are enabled.

[Save in folder]
When the [Save to My Pictures folder] check box is not selected, this text box is 
enabled for you to enter a folder name in which to save scanned images. You 
can also select a folder by clicking [Browse].

[Access setting] Button
This button is enabled when the [Save to My Pictures folder] check box is not 
selected, allowing you to enter the user name and password required to access 
the shared network folder specified for [Save in folder].

NOTE
• Access to shared network folders may be restricted to users with certain access 

permission. In this case, users cannot access the shared folder without entering 
the correct user name and password.

• Confirm the access rights for the shared network folder with the network 
administrator, and then enter the user name and password.

[File name]
Enter a name for the files to save.

File names may consist of up to 32 alphanumeric characters.
A time stamp (YYYYMMDDHHmmSSMMM) is automatically appended to 
the indicating the time of scanning.
Example for a file with the name "Sample" scanned on May 24, 2008 at 9:16 
pm and 32.836 seconds: Sample20080524211632836.pdf

[File type]
Select the file format for saved files from the File type drop-down list.

Selecting [TIFF] , [PDF] , or [JPEG] enables the [Setting] button.

[Setting] Button
This button is enabled to display the corresponding setting dialog box when the 
TIFF, PDF, or JPEG file format is selected.

TIFF setting Dialog Box

[Multi-tiff setting]
Select the method for saving image files when scanning multipage documents.

Select [Single page] to save each page in its own image file.
Select [Multi-page] to save all pages in one image file.

[Compression] Check Box
Select this check box to compress images saved to files. Black-and-white 
(binary) images are compressed in CCITT Group 4 format, and grayscale and 
color images in JPEG format. When this check box is not selected, the saved 
files are larger.

CCITT Group 4: This compression format was designed for data 
communications (such as with fax devices) of black-and-white (binary) 
images.
JPEG: This compression format is for saving grayscale and color images. 
When the [Compression] check box is selected, a standard level of JPEG 
compression is applied.
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If your application program does not support the above compression 
formats, you may be unable to open scanned image files. In this case, 
disable [Compression] when scanning.

PDF setting Dialog Box

 [Multi-pdf settings]
Select the method for saving PDF files when scanning multipage documents.

Select [Single page] to save each page in its own PDF file.
Select [Multi-page] to save all pages in one PDF file.

[Compression rate]
Select the compression rate for PDF files.

Select [Normal] to save files with standard compression.
Select [High Compression] to save files with high compression. Although 
file size is reduced, image quality may be slightly degraded.
Select [Character Precedence] to save files by compressing the file without 
compressing the text to maintain the text's readability.

The Compression rate setting is enabled when the scanner is set to ‘256-level 
Gray’ or ‘24-bit Color’. When [Black and White] or [Error Diffusion] is selected 
from the Mode drop-down list, the file size depends on the content of the 
scanned document.

[Language for OCR]
When the [Apply OCR] check box is selected, the target language for OCR can 
be selected from the Language for OCR drop-down list.

NOTE
Chinese OCR with the Simplified Chinese or Traditional Chinese setting requires a 
Chinese language environment to display properly.

[Apply OCR] Check Box
Select this check box to enable recognition of the text within images and to save 
the recognized text data with the image.

Characters within document images are recognized as text and saved as 
appended text data in PDF (*pdf) files.

JPEG File Setting Dialog Box

[Quality]
Select the balance between high compression and high quality. The files size 
gets larger for a higher image quality because the compression ratio is lower. 
The default setting is ‘Standard’.

[High Quality]: Prioritizes the image quality over the compression ratio. The 
compression ratio is 90.
[Standard]: This is for standard compression. The compression ratio is 75.
[High Compression]: Prioritizes the compression ratio over image quality. 
The compression ratio is 10.
[User]: Use to specify the compression ratio from 0 to 100 using the slide 
bar.
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Settings to Print Scanned Images

[Printer]
Shows the printer to use for printing images. Click [Printer setting] to change 
the printer settings.

[Print format]
Select whether to resize images for printing.

Select [Actual size] to print images in the same size as their original 
documents.
Select [Fit to paper] if the scanned documents are larger than the printer 
paper, to resize the images to the printer paper size.

Buttons
[OK]

Click this button to accept the setting changes and return to the Job 
Registration Tool dialog box.

[Cancel]
Click this button to reject the setting changes and return to the Job 
Registration Tool dialog box.

If the ISIS/TWAIN-compatible application is registered as an event, and the job 
is registered in [Launcher] in the [New/Editing] dialog box, you can perform 
scanning with an application by pressing the Start key on the scanner. The 
following describes how to register ISIS/TWAIN-compatible applications as 
events.

1 From the Windows task bar, click [Start] → [Control Panel].

Setting the Launcher
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2 If the Control Panel is displayed with the Category View, click [Printers and 
Other Hardware] in the working field → click [Scanners and Cameras].
If the Control Panel is displayed with the Classic View, double-click 
[Scanners and Cameras].

Control Panel (Category View) Printers and Other Hardware

Control Panel (Classic View)

3 Right-click [CANON DR-3010C USB] → click [Properties].

4 Click [Events] tab → select [Scan Button] in [Scanner events].

IMPORTANT
• Do not change the settings by selecting [Job Tool] in [Scanner events]. The job 

function may not run normally.
• Do not enable [Disable device events]. The job function will not run 

correctly.

5 Select the check box of applications displayed in the [Send to this 
application] list.
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IMPORTANT
Do not select [DR-3010C Job Tool] displayed in the [Send to this application] 
list. The job function will not run correctly.

NOTE
• If multiple applications are selected, the [Select Application] dialog box is 

displayed when the Start key of the scanner is pressed, and you can select the 
application to execute scanning.

• Applications displayed in [Send to this application] are only the applications 
compatible with the Events Function. However, the processes may not run 
correctly depending on the application. For more information, contact the 
manufacturer of the application you are using.

6 Click [OK].

This dialog box appears when you select [Admin setting] from the [Admin] menu 
in the Job Registration Tool dialog box. You can set Capacity Warning Settings, 
Show Monitor Dialog Setting, Maximum size of attached file, and Back Up /
Restore.

Settings for Monitoring the Folder for Saved Images

[Capacity Warning Settings]
The capacity warning settings enables you to specify in advance the folder for 
saving image files, and the space to be available for saving files. If the space 
required to save a file  exceeds the specified warning size, a warning message 
appears when starting to scan or during scanning.

A warning size (capacity) can be specified for up to five folders. To register a 
warning size for a folder, click the number (1 to 5) of the folder from the 
Register Folder drop-down list.

[Display Warning Dialog] Check Box
Select this check box when you want to limit the space available in a destination 
folder by registering the folder number and specifying a warning size.

Admin Dialog Box
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[Capacity Observed Folder]
Specify a folder to monitor for available space.

[Warning Size]
Enter the maximum total size for all files saved to the specified folder.

When saving to removable storage media such as a CD-R, specify the 
maximum capacity of the media.
When folder monitoring ([Display Warning Dialog]) is enabled, a warning 
message appears when starting to scan if the total size of the files in the 
specified folder exceeds the specified limit.
If a warning message appears, follow the instructions in the message to 
either continue scanning or change the save destination before continuing 
scanning.

Monitor Job Dialog Settings

[Show Monitor Dialog] Check Box
Select this check box to display the Monitor for DR-3010C dialog box to display 
job progress while scanning.

Setting the Maximum Size of E-Mail Attachments

[Maximum size of attached file] Box
Specify the maximum image file size that can be attached to an e-mail message 
when [Attach to E-mail] is selected from the Function drop-down list. When the 
scanned image size reaches the specified maximum, a message appears and 
scanning stops.

The maximum size of attached files must not exceed the limit determined 
by the mail server. Ask your e-mail system administrator for the 
attachment size limit of the mail server.

Job Backup Settings

[Back Up] Button
Writes a backup file (*.reg) of registered job data to the specified folder.

[Restore] Button
Restores the job data from a stored backup file (*.reg).
If a currently registered job number is the same as that of an existing backup 
file, the existing backup file is overwritten by the registered job.

Buttons
[OK]

Click this button to accept changes and return to the Job Registration Tool 
dialog box.

[Cancel]
Click this button to reject changes and return to the Job Registration Tool 
dialog box.
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You can print the registered jobs list in the printing dialog box displayed by 
clicking [Print] in the [Admin] menu. The size of the document printed is approx. 
2.1" x 3.4" (54 mm x 86 mm).

NOTE
As shown in the job number 3 diagram, the end of job titles with a text string that is 
too long are abbreviated with '...'.

Printing Registered Jobs 

   

   

   

   

 

 

 

 

 

 

DR-3010CDR-3010C



66
Chapter 6 Maintenance

1. Regular Maintenance .............................................................. 66

Cleaning the Scanner............................................................................. 66
Cleaning the Inside of the Scanner ........................................................ 66
Cleaning the Sensor Glass and the Rollers ............................................ 67

2. Removing and Attaching the Rollers and Document Holding Guide ........ 69

Roller Replacement Cycle...................................................................... 69
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Removing/Attaching the Retard Roller .................................................. 71
Removing/Attaching the Document Holding Guide................................ 73
Resetting the Counter............................................................................ 74

Clean the scanner on a regular basis, as described below, to maintain peak 
scanning quality.

CAUTION
• When cleaning the scanner and the inside of the scanner, turn OFF the power 

switch and disconnect the power cord from the power outlet.
• Do not use spray cleaners to clean the scanner. Precision mechanisms, such 

as the light source, may get wet, and cause a malfunction.
• Never use paint thinner, alcohol, or other organic solvents to clean the 

scanner. Such solvents can damage or discolor the exterior of the scanner, 
or create a risk of fire or electrical shock.

To clean the exterior of the scanner, dampen a cloth with water or a mild detergent, 
wring the cloth out thoroughly, and then wipe the dirt away. Then use a dry, soft 
cloth to wipe away any moisture.

Dust or paper particles inside the scanner may cause lines or smudges to appear 
on scanned images. Use compressed air to periodically clean dust and paper 
particles from the document feed opening and the inside of the scanner. After 
finishing a large scanning job, turn OFF the scanner and then clean out any paper 
particles remaining inside the scanner.

Cleaning the Scanner

Cleaning the Inside of the Scanner

1. Regular Maintenance
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If scanned images contain streaks, or if the scanned documents become dirty, 
the sensor glass or rollers inside the scanner may be dirty. Clean them 
periodically.

1 Open the document eject tray. (See p.21.)

2 Press the OPEN button ( ) while pulling the front unit open ( ).

3 Use compressed air to remove dust and paper particles from the inside of 
the scanner.

4 Use a clean dry cloth to wipe dirt off the sensor glass.

Wipe both the front and back sensor glasses.

CAUTION
Do not spray water or neutral detergent directly on the scanner. Precision 
mechanisms, such as the light source, may get wet, and cause a malfunction.

IMPORTANT
Scratches on the sensor glass may cause marks on the images, as well as 
feeding errors. If there are scratches on the sensor glass, contact your local 
authorized Canon dealer or service representative.

5 Clean the  rollers by wiping the exposed part without turning them. Clean 
the  rollers while turning them. Wipe the rollers with a cloth that has 
been dampened with water and thoroughly wrung out, and then use a dry, 
soft cloth to wipe away any moisture.

Cleaning the Sensor Glass and the Rollers

Scanning Glass

Retard Roller

Feed Roller
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6 Clean the  rollers by wiping the exposed part without turning them. Clean 
the  rollers while turning them. Wipe the rollers with a cloth that has 
been dampened with water and thoroughly wrung out, and then use a dry, 
soft cloth to wipe away any moisture.

7 Wipe the document holding guide with a cloth that has been dampened 
with water and thoroughly wrung out.

8 Remove the feed roller and retard roller. (See p.69 and p.71.)

IMPORTANT
Remove the feed roller and retard roller from the scanner to clean them, and 
make sure to reattach them to the scanner when cleaning is finished.

9 Wipe the removed rollers with a cloth that has been dampened with water 
and thoroughly wrung out.

10 Reattach the feed roller and retard roller. (See p.70 and p.72.)

11 Close the front unit by gently pushing it up on both sides until it clicks into 
place. Make sure that the front unit is completely closed by pushing until 
you hear a click.

12 Close the document eject tray.

Document
Holding Guide
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To clean or replace the feed roller, retard roller, or document holding guide, 
remove and then attach the parts as described in each respective section.

CAUTION
Do not use excessive force when removing or attaching the rollers and 
document holding guide. Doing so many damage them.

When the rollers have fed more than 100,000 pages, a roller replacement 
message appears on the computer. Purchase an exchange roller kit and replace 
the feed roller, the retard roller, and the document holding guide.

IMPORTANT
• Rollers are consumable parts. When the rollers start to wear out, paper jams 

and misfeeds may occur more often. When this happens, purchase an 
exchange roller kit and replace the feed roller and the retard roller.

• If misfeeds occur often, check the rollers for wear, and replace them if 
necessary before the message is displayed.

• Make sure to reset the counter after replacing the rollers. (See "Resetting 
the Counter," on p. 74.)

• For information about the exchange roller kit (feed roller, retard roller, and 
the document holding guide), contact your local authorized Canon dealer or 
service representative.

To remove or attach the feed roller, follow the procedure below.

CAUTION
Use caution when removing or attaching the feed roller. Using excessive force 
may cause damage or personal injury.

Removing the Feed Roller

1 Open the document eject tray. (See p.21.)

2 Press the OPEN button ( ) while pulling the front unit open ( ).

3 Open the roller cover by placing your fingers in the grooves and pulling it 
down.

Roller Replacement Cycle

2. Removing and Attaching the Rollers and Document Holding Guide Removing/Attaching the Feed Roller

Roller Cover
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4 Lift up the roller fixing lever ( ), and slide it to the left ( ).

5 Remove the feed roller by moving it to the left to detach it from its shaft, 
and pull it out of the slot.

Attaching the Feed Roller

1 Insert the feed roller into the slot inside the roller cover, and align the notch 
on the roller with the shaft on the main unit.

2 Slide the roller fixing lever to the right to lock the roller into the hole on the 
left of the feed roller.

3 Push down the lever to lock the shaft of the feed roller into place.
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4 Close the roller cover. Make sure that the cover is completely closed by 
pushing until you hear a click.

5 Close the front unit by gently pushing it up on both sides until it clicks into 
place. Make sure that the front unit is completely closed by pushing until 
you hear a click.

6 Close the document eject tray.

To remove or attach the retard roller, follow the procedure below.

CAUTION
Use caution when removing or attaching the retard roller. Using excessive force 
may cause damage or personal injury.

Removing the Retard Roller

1 Open the document eject tray. (See p.21.)

2 Press the OPEN button ( ) while pulling the front unit open ( ).

Removing/Attaching the Retard Roller
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3 Open the roller cover inside the front unit using your finger.

4 Lift up the roller fixing lever ( ), and slide it to the right ( ).

5 Remove the retard roller by moving it to the right to detach it from its shaft, 
and pull it out.

Attaching the Retard Roller

1 Insert the retard roller into the slot inside the roller cover, and align the 
notch on the roller with the shaft on the front unit.

2 Slide the roller fixing lever to the left to lock the roller into the hole on the 
left of the retard roller.

3 Push down the lever to lock the shaft of the feed roller into place.

b

a
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4 Close the roller cover. Make sure that the cover is completely closed by 
pushing until you hear a click.

5 Close the front unit by gently pushing it up on both sides until it clicks into 
place. Make sure that the front unit is completely closed by pushing until 
you hear a click.

6 Close the document eject tray.

To remove or attach the document holding guide, follow the procedure below.

CAUTION
Use caution when removing or attaching the document holding guide. Using 
excessive force may cause damage or personal injury.

Removing the Document Holding Guide

1 Open the roller cover, and slide the document holding guide to remove it.

Attaching the Document Holding Guide

1 Fit the hooks (four) of the document holding guide onto the roller cover, 
and slide the document holding guide to attach it.

Removing/Attaching the Document Holding Guide
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After replacing the feed rollers, open the counter settings dialog box and reset 
the counter.

1 From the Windows task bar, click [Start] → [Control Panel].

2 If the Control Panel is displayed with the Category View, click [Printers and 
Other Hardware] in the working field → click [Scanners and Cameras].
If the Control Panel is displayed with the Classic View, double-click 
[Scanners and Cameras].

Control Panel (Category View) Printers and Other Hardware

Control Panel (Classic View)

3 Right-click [CANON DR-3010C USB] → click [Properties].

4 Click the [Maintenance] tab → [Reset].

5 Confirm that the counter for the selected roller is set to 0 → click [OK].

Resetting the Counter
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Chapter 7 Troubleshooting

1. Troubleshooting ..................................................................... 75

2. Uninstalling the Software.......................................................... 79

Uninstalling the ISIS/TWAIN Driver and Job Registration Tool.............. 79
Uninstalling CapturePerfect 3.0 ............................................................. 80

3. Removing the Document Feed Tray .............................................. 81

This section describes the possible problems that might occur during use of the 
scanner and how to solve them.
Refer to the references below that correspond with any problems that you might 
encounter.

The Scanner Does Not Turn ON.................................................................... P. 75
The Scanner Is Not Recognized.................................................................... P. 75
Slow Scanning Speed................................................................................... P. 76
Scanning Is Not Performed .......................................................................... P. 76
Documents Do Not Feed Properly ................................................................ P. 76
Saved Image Files Do Not Open ................................................................... P. 77
Scanning Results Are Not as Expected ......................................................... P. 77
An Error Code Is Displayed on the Display Panel.......................................... P. 78

If, after consulting this section, you still cannot resolve the problem, contact your 
local authorized Canon dealer or service representative.

× The Scanner Does Not Turn ON

Check the following if the scanner does not turn ON:

• Is the power switch turned ON?
• Is the power cord connected correctly?
• Is the power cord inserted into the power outlet?

For details on connecting the power cord, see "Chapter 2 Setup - Connecting the 
Scanner to the Computer," on p.16.

× The Scanner Is Not Recognized

The following are possible causes of the PC failing to recognize the scanner. Check 
each possible cause.

Problem
Solution

The scanner is not connected correctly
Make sure that the scanner and the computer are connected 
correctly with the USB cable. (See "Chapter 2 Setup - Connecting the 
Scanner to the Computer," on p.16.)

1. Troubleshooting
DR-3010CDR-3010C



76
× Slow Scanning Speed

The following problems might cause the scanning speed to be slow. Check each 
possible cause.

× Scanning Is Not Performed

Check the following if the scanner does not scan an image even though the 
scanning operation is performed:

• Has the scanner been properly recognized by the computer?
• Has the scanner driver been installed?
• Has the application software been installed correctly? Has the application 

software been set up correctly?
• Is there a problem in the PC system?

IMPORTANT
• If documents are not scanned normally even if the scanner setup is OK, a 

probable cause is that the scanner driver or application software is not 
running correctly. Reinstall the scanner driver or application software.

• When system errors result in the scanner not functioning at all, turn OFF the 
scanner and wait at least 10 seconds before turning it ON again. If the error 
continues to occur, restart the computer.

• When scanning continues, make sure that the last document scanned was 
scanned correctly.

× Documents Do Not Feed Properly

The following are possible causes of a document failing to feed properly. Check 
each possible cause.

Problem
Solution

The scanner power is switched OFF.
Make sure that the scanner is switched ON. If the scanner is OFF, 
turn the scanner ON.
(See "Chapter 2 Setup - Connecting the Scanner to the Computer," 
on p.16.)

Problem
Solution

The scanner does not support your USB interface.
This product is not guaranteed to operate with all types of USB 
interfaces. Contact your local authorized Canon dealer or service 
representative for more information.

Problem
Solution

The scanner does not support the USB cable.
Use the USB cable provided with the scanner.

Problem
Solution

The USB hub is not compatible with the scanner.
Remove the USB hub.

Problem
Solution

Other applications are running in the background on your PC.
Quit all other applications that are running.

Problem

Solution

Resident applications, such as anti-virus software, are draining 
memory resources.
Quit all resident applications.

Problem

Solution

Temporary files cannot be created in the TEMP folder, as there is 
not enough free space on the hard disk.
Delete unwanted files on the hard disk to increase free space on the 
hard disk.

Problem
Solution

The USB port you are using does not support Hi-Speed USB 2.0.
Scanning speeds are slower if your computer's standard USB 
interface is not compatible with Hi-Speed USB 2.0. (See p.12.) Use a 
computer that is equipped with USB that is compatible with 
Hi-Speed USB 2.0 as standard.

Problem
Solution

The USB cable does not support Hi-Speed USB 2.0.
Use the USB cable provided with the scanner.

Problem
Solution

The USB hub does not support Hi-Speed USB 2.0.
Remove the USB hub.

Problem

Solution

Static electricity is causing the pages of the document to stick 
together, and they cannot be separated correctly by the scanner.
Before you place your document, thoroughly fan the stack of pages. 
(See "Feeding in the Page Separation Mode," on p.22.)

Problem

Solution

Attempting to scan a document of a size, thickness, or weight that 
the scanner cannot scan.
Check the size, thickness, and weight of the document. For 
information on the type of documents that you can use with the 
scanner, see "1. Documents," on p.19.
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For information on removing jammed documents, see "6. Handling Paper Jams/
Double Feed Detection," on p.34.

× Saved Image Files Do Not Open

When image files saved by CapturePerfect 3.0 cannot be opened by other 
applications, the probable causes are as follows. Confirm the status, and use one of 
the following solutions to handle the problem.

× Scanning Results Are Not as Expected

If there is a problem with the scanning result (for example, the scanned image is 
not clear, or the image is striped or dirty) the probable causes are incorrect ISIS/ 
TWAIN driver settings or a problem with the scanning unit inside the scanner. 
Scanning results can also become skewed if the ISIS/TWAIN driver has not been 
installed correctly, or the application in use does not support ISIS/TWAIN driver 
functions.

Problem
Solution

The rollers inside the scanner are dirty or worn.
Clean the rollers. (See p.67.) If the rollers are worn, then they need 
to be replaced. Contact your local authorized Canon dealer or service 
representative to purchase a roller replacement kit. 

Symptoms

Problem

Solution

A multipage TIFF file saved in CapturePerfect 3.0 cannot be 
opened by other applications.
The application you are using to open the TIFF file does not support 
multipage TIFF files.
Open the file with an application that supports multipage TIFF files.

Symptoms

Problem

Solution

A TIFF file saved in CapturePerfect 3.0 cannot be opened by other 
applications.
If the TIFF file saved in CapturePerfect 3.0 has been compressed, the 
application you are using to open the TIFF file does not support the 
compression type that was used to save the file in CapturePerfect 3.0.
Set the compression type for the image file to ‘None’, and save the 
file again in CapturePerfect 3.0.

Symptoms
Problem
Solution

The scanned image is too dark (or faint).
The Brightness setting is set incorrectly.
If the image is dark, click the [Brightness] tab in the Properties for 
Canon DR-3010C dialog box → drag the <Brightness> slider to the 
right to increase the Brightness setting, or if the image is faint, drag 
the <Brightness> slider to the left to decrease the Brightness setting.

Symptoms

Problem
Solution

Text or images on the rear side of your document appear in the 
scanned image.
The Brightness setting is too low, or the paper is too thin.
Click the [Brightness] tab in the Properties for Canon DR-3010C 
dialog box → drag the <Brightness> slider to the right to increase 
the Brightness setting. If the paper is too thin, make a copy of the 
documents and then scan the copy. Alternatively, click the [Image 
processing] tab in the Properties for Canon DR-3010C dialog box → 
select the [Prevent Bleed Through / Remove Background] check 
box.

Symptoms
Problem
Solution

Double-sided scanning is not possible.
The Scanning Side drop-down list is set to ’Simplex’.
Click the [Basic] tab in the Properties for Canon DR-3010C dialog 
box → select [Duplex] from the Scanning Side drop-down list.

Symptoms
Problem
Solution

The scanned image is skewed.
The document has been fed at an angle (skew).
Use the document guide adapter to prevent document skew. Click 
the [Basic] tab in the Properties for Canon DR-3010C dialog box → 
select the [Deskew] check box.

Symptoms
Problem
Solution

Lines, smudges, or dirt appear on the scanned image.
The scanning glass or rollers inside the scanner are dirty.
Clean the scanning glass and rollers. If lines still appear on the 
image even after cleaning the scanning glass and rollers, the 
scanning glass inside the scanner may be scratched. Contact your 
local authorized Canon dealer or service representative.

Symptoms
Problem
Solution

There are abnormalities in the image.
The scanning glass or rollers inside the scanner may be dirty.
Clean the scanning glass and rollers. If there are still abnormalities 
in the image even after cleaning the scanning glass and rollers, the 
scanning glass inside the scanner may be scratched. Contact your 
local authorized Canon dealer or service representative.
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× An Error Code Is Displayed on the Display Panel

The following are possible causes of an error message displayed on the display 
panel of the scanner.  Check each possible cause. 

Symptoms
Problem
Solution

The size of the document could not automatically be detected.
The scanning glass or rollers inside the scanner may be dirty.
Clean the scanning glass and rollers. If the auto-detection of the 
paper size fails even after cleaning the scanning glass and rollers, 
the scanning glass inside the scanner may be scratched. Contact 
your local authorized Canon dealer or service representative.

Symptoms
Problem
Solution

The scanned image is abnormal in some applications.
A function not supported by the application was used.
Some applications do not support functions, such as auto-detection 
of the paper size. Scanning documents with an application such as 
this will result in an abnormal scanned image. Try scanning without 
setting auto-detection of the paper size.

Error Code

Problem
Solution

This error code is displayed if the front unit of the scanner is open.
Close the front unit of the scanner. For more information on closing 
the front unit, see "6. Handling Paper Jams/Double Feed Detection," 
on p.34.

Error Code

Problem
Solution

This error code is displayed if a paper jam is detected.
Open the front unit of the scanner, and remove the document. For 
more information on removing documents, see "6. Handling Paper 
Jams/Double Feed Detection," on p.34.

Error Code

Problem
Solution

This error code is displayed if a double feed is detected.
Open the front unit of the scanner, and remove the document. For 
more information on removing documents, see "6. Handling Paper 
Jams/Double Feed Detection," on p.34.

Error Code

Problem
Solution

This error code is displayed if another type of error occurs.
Turn off the power switch, wait 10 seconds, and then turn the power 
switch on again. If the "E" error code is still displayed, contact your 
local authorized Canon Dealer, or service representative.
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If the ISIS/TWAIN driver, Job Registration Tool, or CapturePerfect 3.0 are not 
operating normally, follow the procedure below to uninstall them. Then, 
reinstall the software from the DR-3010C setup disc. (See "2. Installing the 
Software," on p.13.)

IMPORTANT
Log on to Windows as an Administrator.

1 From the Windows task bar, click [Start] → [Control Panel].

2 Double-click [Add or Remove Programs].

The [Add or Remove Programs] dialog box appears.

1 From the Programs list, click [Canon DR-3010C Driver] (or [DR-3010C Job 
Tool]) → click [Remove].

NOTE
If you clicked [DR-3010C Job Tool], click [Change/Remove].

2. Uninstalling the Software

Uninstalling the ISIS/TWAIN Driver and Job Registration Tool
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2 Click [Yes] in the DR-3010C Setup dialog box.

NOTE
To remove the Job Registration Tool, click [Yes] in the Confirm File Deletion dia-
log box.

3 Click [Finish].

NOTE
When removing the Job Registration Tool, click [Yes To All] in the Remove 
Shared File dialog box → click [Yes]. After the uninstallation procedure is     
complete, click [OK].

1 From the Programs list, click [CapturePerfect 3.0] → [Remove].

2 Click [Yes] in the CapturePerfect 3.0 Setup dialog box.

3 Click [Finish].

Uninstalling CapturePerfect 3.0
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The machine cannot be returned to its packaging with the document feed tray 
attached. 
To return the machine to its packaging for storage or repair, follow the procedure 
below to remove the document feed tray. 

1 Push the document guides to the center of the machine.

2 Pull up the document guides while holding the document feed tray to 
unsnap the document guides from the document feed tray.

3 Pull to remove the document feed tray while the back of the document 
guide is unsnapped from the document feed tray.

3. Removing the Document Feed Tray
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Main Unit

Specifications

Type Desktop sheetfed scanner

Scanning Document Size

Plain Paper

Size Width: 1.97" to 8.5" (50 mm to 216 mm)
Length: 2.12" to 14.02" (53.9 mm to 356 mm)*

Paper weight: 
(Page separation mode)

14 to 54 lb bond (52 to 209 g/m2) 
0.0024" to 0.01" (0.06 mm to 0.25 mm)

Paper weight: 
(Bypass mode)

11 to 54 lb bond (40 to 209 g/m2) 
0.002" to 0.01" (0.05 mm to 0.25 mm)
*You can scan documents up to 39.2" (1000 mm) long 

by setting the scanner to the Long Document mode. 
(See "Setting the Long Document Mode," on p. 36.)

Business Card Size:
Paper weight:

1.97" x 2.12" (50 mm x 53.9 mm) or larger
140 lb bond (300 g/m2) 0.0138" (0.35 mm) or less

Card Size:

Card thickness:
Orientation:

2.12" x 3.37" (53.9 mm x 85.5 mm)
(ISO7810 standard)
0.03" (0.76 mm) or less
Horizontal feeding only
Embossed cards can be scanned.

Document Feeding Method Automatic

Scanning Sensor Contact image sensor

Light Source LED

Scanning Side Simplex/Duplex

Scanning Modes Black and White, Error Diffusion, 256-level Grayscale, 
Advanced Text Enhancement, Advanced Text 
Enhancement II, 24-bit Color

Scanning Resolution
(Primary Scan Lines x Secondary 
Scan Lines)

100 x 100dpi/150 x 150dpi/200 x 200dpi/ 
240 x 240dpi/300 x 300dpi/400 x 400dpi/ 
600 x 600dpi

Scanning Speed
(Conditions: Pentium 4 3.2 GHz CPU, 1 GB memory, LTR/A4 document size)

Black and White Simplex 200 x 200 dpi 30 pages/min.

300 x 300 dpi 30 pages/min.

Duplex 200 x 200 dpi 60 images/min.

300 x 300 dpi 60 images/min.

Specifications
DR-3010CDR-3010C



83
AC Adapter (100 to 240 V type)

Exchange roller kit (product code: 3335B001AA)
Kit to replace the rollers (retard roller, feed roller) and document holding guide.
• For information on replacing the rollers, see "Removing/Attaching the Feed 

Roller," on p. 69. and "Removing/Attaching the Retard Roller," on p. 71.
• For information on replacing the document holding guide, see "Removing/

Attaching the Document Holding Guide," on p. 73.
• Contact your local authorized Canon dealer or service representative for 

detailed information about the replacement parts.
Product specifications are subject to change without notice.

Grayscale Simplex 200 x 200 dpi 30 pages/min.

300 x 300 dpi 30 pages/min.

Duplex 200 x 200 dpi 60 images/min.

300 x 300 dpi 60 images/min.

24-bit Color Simplex 100 x 100 dpi 30 pages/min.

200 x 200 dpi 30 pages/min.

Duplex 100 x 100 dpi 60 images/min.

200 x 200 dpi 60 images/min.

Interface Hi-Speed USB 2.0

Other Functions Auto document thickness adjustment, folio scanning

External Dimensions 12.2" x 11.5" x 7.8" (W x D x H)
310 mm x 292 mm x 197 mm (W x D x H)

Weight (without AC adapter) Approximately 6.4 lb (2.9 kg).

Power Supply (using AC adapter) DC 16 V, 1.0 A

Power Consumption Scanning: Maximum 16.5 W
In the Sleep mode: Maximum 3.7 W
With power switch OFF: Maximum 0.5 W

Noise Not more than 66 dB

Operating Environment Temperature: 10°C to 32.5°C (50°F to 90.5°F)

Humidity: 20% to 80% RH

Model Number MG1-4315

Input AC 100-240 V, 50/60 Hz, 0.65-0.34 A

Output DC 16 V, 1.8 A

Weight Approximately 0.3 kg (including power cord)

Replacement Parts
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External Dimensions
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FCC REGULATIONS (For 120 V model)
Document Scanner, Model M11066
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired 
operation.
Note: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment OFF and ON, the user is encouraged to 
try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Use of shielded cable is required to comply with class B limits in Subpart B of Part 
15 of FCC Rules.
Do not make any changes or modifications to the equipment unless otherwise 
specified in the manual. If such changes or modifications should be made, you 
could be required to stop operation of the equipment.
Canon U.S.A. Inc.
One Canon Plaza, Lake Success NY 11042, U.S.A.
Tel. No. (516)328-5000
RADIO INTERFERENCE REGULATIONS (For 120 V models)
This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus as set out in the Interference-causing equipment standard 
entitled "Digital Apparatus", ICES-003 of the Industry Canada.
RÈGLEMENT SUR LE BROUILLAGE RADIOÉLECTRIQUE (For 120 V models)
Cet appareil numérique respecte les limites de bruits radioélectriques applicables 
aux appareils numériques de Classe B prescrites dans la norme sur le matériel 
brouilleur: "Appareils Numériques", NMB-003 édictée par l’Industrie Canada.

European Union (and EEA) only.
This symbol indicates that this product is not to be disposed of with 
your household waste, according to the WEEE Directive (2002/96/
EC) and your national law. This product should be handed over to a 
designated collection point, e.g., on an authorized one-for-one 
basis when you buy a new similar product or to an authorized 
collection site for recycling waste electrical and electronic 

equipment (EEE). Improper handling of this type of waste could have a possible 
negative impact on the environment and human health due to potentially hazardous 
substances that are generally associated with EEE. At the same time, your 
cooperation in the correct disposal of this product will contribute to the effective 
usage of natural resources. For more information about where you can drop off 
your waste equipment for recycling, please contact your local city office, waste 
authority, approved WEEE scheme or your household waste disposal service. For 
more information regarding return and recycling of WEEE products, please visit 
www.canon-europe.com.
(EEA: Norway, Iceland and Liechtenstein)
MODEL NAMES
Model DR-3010C is identical to model M11066.
Model DR-3010C is the sales name of model M11066.
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B
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C
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Cards, placing.................................................................................................... 24
Cleaning

Document holding guide........................................................................... 68
Main body................................................................................................. 66
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Counter, resetting .............................................................................................. 74

D
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Disposal............................................................................................................... 8
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Document feeder ............................................................................................... 10
Document guides............................................................................................... 10
Document holding guide

Attaching .................................................................................................. 73
Removing ................................................................................................. 73

Documents ........................................................................................................ 19
Placing...................................................................................................... 22

Double feed detection ........................................................................................ 52
Driver................................................................................................................. 13

E
Extension tray .................................................................................................... 10

F
Features ............................................................................................................... 8
Feed roller

Attaching .................................................................................................. 70
Removing ................................................................................................. 69

Feed Selection lever ........................................................................................... 11
Folded documents, placing ................................................................................ 25
Front unit ........................................................................................................... 10

H
Handling .............................................................................................................. 7

I
Installation location.............................................................................................. 5
Introduction ......................................................................................................... 3
ISIS/TWAIN Driver Properties Dialog Box.......................................................... 39

Auto color detection.................................................................................. 41
Background, removing.............................................................................. 50
Breed through, preventing ........................................................................ 50
Brightness, adjusting ................................................................................ 47
Contrast, adjusting.................................................................................... 47
Deskewing ................................................................................................ 44
Double feed detection ............................................................................... 52
Feeding options ........................................................................................ 53
Gamma curve settings .............................................................................. 48
Image contour, adjusting.......................................................................... 49
Moire, reducing ........................................................................................ 45
Omitting a special color ............................................................................ 51
Paper size settings.................................................................................... 42
Prescan..................................................................................................... 54
Recovering from the error ........................................................................ 52
Red color, enhancing................................................................................ 51
Registering scan conditions...................................................................... 55
Resolution, setting.................................................................................... 43
Rotating image ......................................................................................... 49
Scan area, adjusting ................................................................................. 45
Scan mode setting .................................................................................... 40
Scanning side settings.............................................................................. 43
Text orientation, correcting....................................................................... 50
Version, checking ..................................................................................... 55

J
Job function....................................................................................................... 28
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Job Registration Tool......................................................................................... 56

K
Kensington......................................................................................................... 10

L
Launcher, setting ............................................................................................... 61
Load limit mark.................................................................................................. 22
Long Document mode ....................................................................................... 36

M
Maintenance ...................................................................................................... 66
Minus key .......................................................................................................... 10
Moving the scanner ............................................................................................. 6

N
Name of parts .................................................................................................... 10
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OPEN button ...................................................................................................... 10
Operating system............................................................................................... 12
Operation panel.................................................................................................. 10
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Page Separation mode....................................................................................... 22
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Plus key ............................................................................................................. 10
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Power indicator.................................................................................................. 10
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Trays......................................................................................................... 21
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Retard roller

Attaching .................................................................................................. 72
Removing ................................................................................................. 71

Roller, replacing

Counter, resetting ..................................................................................... 74
Replacement cycle .................................................................................... 69

S
Scan Panel ......................................................................................................... 30
Scanning methods............................................................................................. 26
Service............................................................................................................... 75
Setup disc.......................................................................................................... 13

Custom Installation................................................................................... 13
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Software
Installing................................................................................................... 13
Uninstalling............................................................................................... 79
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Security setting for PDF............................................................................ 33
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Stop key............................................................................................................. 10
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